Member and Leaders Services (MLS) Software Manual

This manual can be best used as a reference while working in the MLS program.

For additional information, see the clerk lesson titled “Introduction to Member and Leader Services (MLS) Software,” located on LDS.org. Click **Menu, Serving in the Church**, and then select **Melchizedek Priesthood**. Click **Leader Resources**. Scroll down the screen, and then click **Record-Keeping and Auditing Training**. The lesson is under the heading “Stake and Ward Clerks.”

The Member and Leader Services (MLS) software is used to track information such as membership records, ordinances, donations, and class attendance. The main MLS screen is the one that appears after you log in (see below). All tasks in this document assume you are on this screen when you begin. Although these instructions may mention only one way to navigate to a task, there are usually multiple ways to navigate to the same place. Use the navigation method you are most comfortable with.

![MLS Main Screen](image)

**Navigating in MLS**

- Text strings in blue are links to other pages or features.
- Some screens have navigation buttons ![left arrow](image), ![right arrow](image). Click the left button (or F3) to go to the previous record. Click the right button (or F4) to go to the next record.
- Click the magnifying glass icon, ![search](image) or ![select](image), to display a chooser window with a list for you to choose from.

© Intellectual Reserve, Inc. All rights reserved. English approval. 6/11. 06765
## Contents

This manual contains instructions for the most commonly used tasks in MLS. For tasks not included in the manual, see the MLS Menu Structure (Appendix B). For additional help, you can also call your stake clerk or another knowledgeable clerk within the stake.

### Finance

- **Budget**
  - Adding or Updating Budget Categories .................................. 3
  - Adding Subcategories ............................................................ 3
  - Changing Subcategory Names .................................................. 3
  - Deleting Subcategories ........................................................... 3
  - Deactivating Subcategories ...................................................... 4
  - Allocating Budget ................................................................... 4
  - Printing the Budget Report ...................................................... 4

- **Paying for Online Store Purchases through the**
  - **Ward or Branch** ................................................................. 5

- **Donations** ........................................................................... 6

- **Expenses** ............................................................................. 6
  - Printing Checks ....................................................................... 6
  - Printing the Expense Report .................................................... 6

- **Tithing Settlement** ............................................................... 7

### Membership

- **Audit** .................................................................................... 7

- **Callings** ............................................................................... 7
  - Recording Regular Callings ...................................................... 7
  - Recording Custom Callings ..................................................... 7
  - Members with Callings Report .................................................. 8
  - Members without Callings Report .......................................... 8

- **Certificates** ......................................................................... 9

- **Confidential Reports and Forms** ........................................... 9

- **Create Records** .................................................................... 9
  - Child Blessing or New Child of Record .................................... 9
  - Nonmember Record ................................................................. 10
  - Out of Unit Member Record .................................................... 11

- **Home and Visiting Teaching** .............................................. 11
  - Creating Home (or Visiting) Teaching Districts and Assigning District Supervisors .............................................. 12
  - Creating Home (or Visiting) Teaching Companionships and Assigning Families (or Sisters) to Teach .............................................. 12
  - Recording Home Teaching Visits (or Visiting Teaching Contacts) ........................................................................... 12

- **Moving Records** .................................................................... 13
  - Moving Records into the Ward ............................................... 13
  - Moving Records out of the Ward ............................................ 13

- **Other Membership Tasks** .................................................. 13
  - Canceling a Record .................................................................. 13
  - Priesthood Ordination ............................................................. 14
  - Recording a Death ................................................................... 14
  - Special Requests ..................................................................... 14

- **Temple Recommends** .......................................................... 14
  - Activating Temple Recommends ............................................ 14
  - Changing Temple Recommend Status ..................................... 15

- **Updating Membership Records** ........................................ 15

### MLS Messages

- Reading a Received Message .................................................. 15
- Creating and Sending a Message ............................................ 16

### Forms

- Officers Sustained ................................................................. 16
- Ordinance Record Forms ....................................................... 16

### Reports and Directories

- Action and Interview List ..................................................... 17
- Directories .............................................................................. 17
- Telephone and E-mail Directory ............................................ 17
- Abbreviated Directory ............................................................. 17
- Directory of Members ............................................................. 18
- Priesthood and Auxiliary Class Rolls and Lists ....................... 18
  - Adding Classes ..................................................................... 18
  - Class Rolls and Lists .............................................................. 18
- Callings by Organization Report ............................................. 18
- Quarterly Report ..................................................................... 19
- New Member Record .............................................................. 19
- Donor Statements .................................................................... 19
- Individual Ordinance Summaries (IOS) .................................. 20
- Custom Reports ..................................................................... 20
  - Create Custom Reports ......................................................... 21
  - Use Custom Criteria ............................................................... 21
  - Complete Talents and Interests Fields .................................... 22
  - Complete the Custom Member Fields for Each Active Member ............................................ 22
- Membership Record Validation Report ................................ 22

### Seminary and Institute

- Seminary Enrollment Progress ............................................. 22
- Released-Time Preregistration ................................................ 22
- Seminary Attendance Report .................................................. 23
- Seminary Graduation Report ................................................. 23
- Institute Enrollment Progress ................................................. 23
- Institute Attendance Report ................................................... 24
- Institute Graduation Report .................................................... 24

### Users and Rights

- Assigning Rights .................................................................. 24
- Adding Users ......................................................................... 24
- Passwords .............................................................................. 25

### Appendices

- **A: MLS Membership and Financial Policies** ..................... A-1
- **B: MLS Menu Structure** .................................................... B-1
Finance

Budget

Adding or Updating Budget Categories

There are three things to remember when adding or updating categories.

1. Only the Budget and Other categories have subcategories that can be added to.
2. You can create a subcategory only under a permanent subcategory, not under a category itself. For example, the Budget category has several permanent subcategories that cannot be deleted, such as Activities, Elders, High Priests, Relief Society, and so on. You would choose one of these to create a subcategory under.
3. The Ward Missionary fund has subcategories, but they are set up by the Missionary Department of the Church and correspond to all missionaries called from your ward who are part of the equalized payment system. They cannot be added to or deleted.

The Add/Update Categories screen shows all categories set up to receive funds in MLS and those subcategories attached to the categories. Note the following:

- Categories in red cannot be changed and cannot have subcategories added to them.
- Categories in black may have subcategories added to them.
- Subcategories with a green bullet (•) next to them are custom subcategories that your unit added to the list. These may be deleted if they are no longer needed, but only after the retention period for financial records has passed. This retention period varies from country to country.

Adding Subcategories:

1. On the MLS menu bar, click Finance. Click Budget. Click Add/Update Categories.
2. Click the plus sign (+) next to a category to show its permanent subcategories. Click the plus sign (+) next to the permanent subcategory you want to create a subcategory under. Make sure the subcategory you are about to add does not already exist.
3. Click the name of the permanent subcategory you want to add a subcategory to.
4. To create a subcategory under the one you have selected, click Add.
5. A new subcategory appears at the bottom of the list. Enter a name for the new subcategory. Press Enter. The new subcategory is ready for use.

Changing Subcategory Names:

1. Click the plus sign (+) next to the permanent subcategory to show the subcategory you want to rename.
2. Click the name of the subcategory to highlight it. Only subcategories with a green bullet (•) can be renamed.
3. Press F2 to highlight the text.
4. Type the new name of the subcategory. Press Enter.

Deleting Subcategories:

Each country has its own laws about how long organizations like the Church have to retain financial records. This is called the retention period. For example, the retention period in the United States is three years. In Canada it is five years. In Australia it is seven years. If you have had financial activity in a subcategory within your country’s retention period, the subcategory cannot be deleted.

If a subcategory has never been used or the retention period has passed for all activity in the subcategory, it can be deleted.

If a subcategory is no longer needed, but there has been financial activity in it and the retention period has not passed, it can be deactivated. (See below.)

1. To delete a subcategory, click the plus sign (+) next to the permanent subcategory to show the subcategory you want to delete.
2. Click the name of the subcategory to highlight it. Subcategories with a red X are default categories and cannot be deleted. Only subcategories with a green bullet (•) beside them can be deleted.
3. Click Delete.
4. Click Yes.

Note: If you try to delete a subcategory that has been used within the mandatory record-retention period of your country, you will get a message saying you cannot delete it because it is being currently used.
Deactivating Subcategories:
If a subcategory is no longer needed, but the retention period has not passed, you can deactivate the subcategory.
1. Click the name of any subcategory with a green bullet beside it.
2. In the gray part of the screen, click the Active check box to remove the check mark.
   - This subcategory will no longer appear on donation screens or budget screens.
   - To reactivate the subcategory, click the Active check box so that the check mark appears.
   - After the record retention period has passed, the subcategory will be deleted automatically at the end of the year.

Allocating Budget
The budget tool in MLS will allow you to allocate budget and track expenses for each budget category.

On the MLS menu bar, click Finance. Click Budget. Click View/Edit Budget.
On this screen, you can assign (allocate) budget amounts to budget subcategories you have previously set up. You may also change budget amounts. Note the following:

On the Bottom of the Screen:
- The Total Estimated/Actual Allowance field shows the total estimated amount of budget for your ward for the year.
  *Note:* In most areas budget is allocated quarterly. On this screen you can enter an estimated amount for each quarter, thereby getting the estimated amount for the entire year.
- The Budget Assigned by Unit field shows the total amount of allowance allotted to the Budget subcategories by the unit.
- The Difference field shows the difference between the budget and the allocation.

In the Budget Area:
- The Budget Assigned by Unit column shows the amount of budget allocated to each of the categories and subcategories.
- The % of Budget column shows what percentage of the total budget each amount is.
- The bolded amount shown at the top of the Budget area is the total amount of budget you have allocated to all the categories and subcategories. This should equal the amount shown at the bottom of the screen in the Total Estimated/Actual Allowance field.
- The Difference field at the bottom of the screen shows the difference between the budget and the allocation.

To allocate budget:
1. In the Estimated/Actual column, enter the amount of budget allowance the stake has allocated to your ward for each quarter of the year (some amounts will be estimates).
2. In the Budget Assigned by Unit column, enter the amount of budget allowance assigned to each category and subcategory for the entire year.
3. As you enter budget amounts, watch the Difference field to make sure you do not exceed the allocation. The total amount of budget you assign should never exceed the amount in the Total Estimated/Actual Allowance field.

Printing the Budget Report
2. In the Date Range field, click the down arrow, and click the time span you want to include in the report.
3. In the Type field, click the down arrow, and click Detail, Summary, or Auxiliary Summary.
   *Note:* The detail report shows the allocation, individual income and expenses, and remaining budget for each category.
4. On the left side of each category and subcategory, there is a check box. By default, these will all be checked, indicating that they will all appear on the report. For those categories you do not want to appear on the report, click the check box to make the check mark disappear.
5. Click Print Selected Items at the bottom of the screen.
Paying for Online Store Purchases through the Ward or Branch

Where available, members and others can order Church items from the Church Online Store (store.lds.org) and pay for them through their local ward or branch.

The person who placed this order will print out a receipt from the Online Store, called the Quote Receipt. They put the total cost of the items, whether currency, coins, or a check written to the local unit, in an envelope with the Quote Receipt and give the sealed envelope to a member of the bishopric.

To process these purchases –
1. Verify that the amount received matches the amount shown on the Quote Receipt.
2. Complete the following steps in MLS:
   a. On the MLS Main screen click Enter Donations, enter the Date for Donations, and click OK.
   b. From the list of existing donors, select the correct donor name, or click Add to enter a new donor name.
   c. On the left side of the Donation page, from the list of donation categories, select Other.
   d. From Other Details, click on the magnifying glass.
   e. From the list of subcategories, select Other: Online Store Purchases, then click OK.
   f. From Other Details:
      i. In the Amount column, enter the amount received with the Quote Receipt.
      ii. In the Quote Number column, enter the 10-digit Quote Number from the Quote Receipt, then click OK to return to the main Donation page.
3. On right side of the Donation page, enter the amount of checks, currency, or coin received.
4. Make sure the Slips Total and the Funds Total are equal, then click Save Donation.
5. Continue with the normal procedures to complete, close, and transmit the donation batch.

Note: This purchase will appear on unit financial reports. The order will be sent after the payment is processed.

Donations

Two priesthood bearers, usually a member of the bishopric and a clerk, open the tithing envelopes and make sure the amount of money in each envelope matches the amounts on the Tithing and Other Offerings slip included in the envelope.

Below is the most common procedure for recording donations and then transmitting the amounts to the administrative office. Your procedure could vary slightly.
1. On the MLS menu bar, click Finance. Click Enter Donations.
2. Enter the date the donations are being entered and click OK.
3. Click the name of the member whose donations you want to record, and then click OK.
   Note: If necessary, click the magnifying glass icon and choose a donor from the list. Using the Tithing and Other Offerings slip as a source, enter amounts on the left side of the screen. (For categories that are in blue text, see “Using the Category Details Box” below.)
4. Using the Tithing and Other Offerings slip as a source, enter amounts on the left side of the screen. (For categories that are in blue text, see “Using the Category Details Box” below.)
   Using the Category Details Box: Click a category name in blue text (these can be Ward Missionary, Budget, and Other). In the Details box, click the magnifying glass icon and choose a donor from the list. In the Details box, click the magnifying glass icon and choose the correct subcategory from the list. Enter the amount being donated to this subcategory. Click OK.
5. Enter amounts of checks, currency, and coins on the right side of the screen. Click Save Donation.
6. When finished with all donations, click Next.
7. On the Review screen, make sure all amounts are correct. To correct error, click Previous to return to the donation screen. When all errors are corrected, click Next.
8. Carefully count the total amount of currency (cash) and coins. On the left side of the Balance screen, enter the totals in the appropriate fields.
9. On the right side of the screen carefully compare the amount of each check with the amount on the screen. Click the check box for every check amount that is correct. Click Next.
10. On the Authorize screen, two persons with finance rights enter their user names and passwords. One of these should be a member of the bishopric.
   Note: Some wards and branches will mail a tithing remittance check as part of their financial procedures and will enter a tithing remittance check number at this point. Others will have a deposit date or a deposit serial number and will enter that at this point.
11. Click Authorize. Click OK, and then click Next.
15. File the Unit Copy of the Deposit Report in your ward or branch files with the Tithing and Other Offerings slips and the Batch Report. Place the Bank Copy of the Deposit Report in the envelope with the money for deposit in the bank.

Expenses
Depending on your location, your procedure for recording expenses may vary slightly from the following. If you have questions, contact your administrative office.
1. On the MLS menu bar, click Finance. Click Enter Expenses.
2. In the Date field, enter the date of the expense.
3. In the Payee field enter the name of the payee or click the magnifying glass icon and choose the payee from the list. If the payee is not on the list, click Add, and complete the payee information.
4. In the Purpose field, enter the purpose of the expense.
5. In the Category field, enter the category from which the payment was made, or click the magnifying glass icon and choose the category from a list.
   Note: If you are in an area where the Church is required to pay sales or other taxes on purchases, the first category will be the tax category. You must complete this field before you go on.
6. In the Amount field, enter the amount of the expense.
   Note: If you are in an area where the Church is required to pay sales or other taxes on purchases, the amount will be the total amount minus the tax amount.
7. If the payment is from more than one category, repeat steps 5 and 6.
8. If the subcategory was from fast offerings, in the Fast Offering Recipient field, enter the name of the member receiving aid.
9. Click Save.
10. When finished recording expenses, click Next.

Printing Checks
If your unit prints checks, you will have received check stock from the administrative office. Check stock consists of individual sheets of paper with preprinted information and the Church logo on them. Each page of check stock is individually numbered. Checks should be used in sequence. Be sure to load the check stock in the printer before printing checks. Remove it when you are done.
   Note: If you do not print checks from MLS, skip this section and go to “Printing the Expense Report” below.
1. Click the check box next to each expense you want to print a check for.
2. Click Print/Authorize.
3. In the Next Check Number field, make sure the check number is the same as the number printed on the next sheet of check stock. If it is not, change it to the correct number. Click OK.
4. For each check:
   • Review the check information. If it is correct, click Print.
   • Click OK.
   • If the check prints correctly, click Yes.
5. When finished printing checks, you should be on the Report screen. If not, click Next.

Printing the Expense Report
You should print and file the Expense Report each time you enter expenses. To print the report, click Print at the bottom of the screen. After printing the report, click Close.
Tithing Settlement

There is a tithing settlement lesson for many languages on LDS.org. From the home page, follow this path: Menu > Service > Serving in the Church > Melchizedek Priesthood > Leader Resources > Record-Keeping and Auditing Training. From this page, first choose your language. Then look for the lesson titled “Tithing Settlement.” This lesson will take you through the steps of tithing settlement.

If the tithing settlement lesson is not available in your language, you should receive instructions from your administrative office.

Membership Audit

The stake clerk or another stake representative performs the membership audit in MLS on each ward’s computer. The audit is performed once a year and should be done by June 30. MLS uses a computer “wizard” to display membership information and ask questions. The stake clerk responds based on the ward clerk’s answers.

1. On the MLS menu bar, click Other Resources. Click Church Audits. Then click Membership Audit.
2. Read the instructions on the screen, and click Next.
3. The High Priests screen lists priesthood holders who might be eligible to be ordained high priests. Examine the list, looking for anyone who has been ordained a high priest. Click the box beside the name of anyone listed who has been ordained a high priest. When you have finished this task, click Yes. Click Next.
4. The Elders screen lists brethren who could be eligible to receive the Melchizedek Priesthood. Examine the list, looking for anyone who holds the Melchizedek Priesthood. Click the box beside the name of anyone who has received the Melchizedek Priesthood and been ordained an elder. When you have finished this task, click Yes. Click Next.
5. The Aaronic screen lists young men who, according to their age, have not been ordained to the expected Aaronic Priesthood office. Examine the list, looking for anyone with an incorrect priesthood office. Click the box beside the name of any young man showing an incorrect priesthood office. When you have finished this task, click Yes. Click Next.
6. The Baptisms screen lists children who are eligible to be baptized but whose records indicate they have not been. Examine the list for children who have actually been baptized and confirmed. Click the check box next to the name of each child who has been baptized and confirmed. When you have completed this task, click Yes. Click Next.
7. The Marriages screen lists adults who are age 31 and older and whose records indicate they are not married. For each of these adults who actually are married, click the box next to the name. When you have completed this task, click Yes. Click Next.
8. The Error Correction screen is a list of items found on the Membership Validation Report, including any items that have been hidden using the Ignore button. Click the check box next to each item that can be corrected. When you have completed this task, click Yes. Click Next.
9. On the Policies screen, answer each statement by clicking either Yes or No. Then click Yes to indicate you have finished. Click Next.
10. Click Print at the bottom of the screen to print a list of audit exceptions that need to be corrected. The bishop should complete the second and third columns of the audit report, showing who will correct each exception and by when. The bishop and the clerk sign and date the report. The stake clerk or his representative takes a copy of the report to the stake. The ward keeps the other copy.
11. Click **Submit** at the bottom of the screen to send the Membership Record Audit Report to the administrative office.

**Callings**

Callings in organizations can be recorded in two ways: (1) you can record callings in any organization by using the Callings by Organization screen (except custom callings) and (2) you can record regular and custom callings in an organization by clicking the organization’s link on the Organizations menus (see below).

**Recording Regular Callings**

1. On the MLS menu bar, click **Organizations**. On the drop-down menu, find the name of the organization you want to record callings for, and click the name. (For example, to record callings for the Relief Society, click **Relief Society**.)
2. To record a leadership calling, in the Leadership Callings section, click **Add Position**. (In MLS a calling is called a position.)
3. In the Position field, click **Select**. Click the name of the position in the list. Click **OK**.
4. If the position is not listed, click **Add**, and enter the name of the position.
5. In the Person Being Called section, click **Select**. Click the name of the person to fill this calling. Click **Save**.
6. In the Date Sustained field, enter the date the member was sustained to this calling. Click **OK**.
7. If the member was set apart, click **Yes**. Click **Save**.
8. To add other callings, in the Other Callings section, click **Add Position**. Repeat steps 3 through 6 as needed.

**Recording Custom Callings**

1. On the MLS menu bar, click **Organizations**. On the drop-down menu, find the name of the organization you want to record calling for, and click the name. (For example, to record callings for the Relief Society, click **Relief Society**.)
2. On the left side of the screen, click **Custom Positions**. (In MLS, a calling is called a position.)
3. Click **Add New Position**.
4. Enter the name of the custom calling (example: Activities Chair). Click **Yes** if this is considered part of the organization leadership. Click **No** if it is not considered part of the organization leadership. Click **Save**.
5. On the left side of the screen, click the name of the organization. In the Other Callings section, click **Add Position**.
6. To record the custom calling, follow steps 3 through 6 under “Recording Regular Callings” above. The custom calling you created should appear as one of the callings in the list of positions.

**Members with Callings Report**

Once callings have been recorded, you can print a report called Members with Callings. It is an alphabetical list of members and their callings.

- To bring the report up on the screen, on the MLS menu bar, click **Organizations**. Click **Reports/Tools**. Click **Members with Callings**.
- To change the order of the list of callings, click a column heading. For example, to list the callings by organization, click the **Organization** column heading. To list the callings by the date the member was sustained, click the **Date Sustained** column heading.
- To print the report, click the **Print** button at the bottom of the screen.

**Members without Callings Report**

Once callings have been recorded, you can print a report called Members without Callings. It is an alphabetical list of members twelve years of age and up who do not have callings.

- To bring up the report on the screen, on the MLS menu bar, click **Organizations**. Click **Reports/Tools**. Click **Members without Callings**.
- To change the order of the list of members who have no calling, click a column heading. For example, to list the members by age click the **Age** column heading. To list the members by their date of birth, click the **Birth Date** column heading.
- To print the report, click the **Print** button at the bottom of the screen.
Certificates

All certificates are found in the same place in MLS. The following example is for the Child Blessing Certificate, but the general instructions apply for all certificates.

1. On the MLS menu bar, click Reports/Forms. Click Certificates.
2. On the list that appears, click the certificate you want to print (in this example, the Child Blessing Certificate). Click OK.
3. Click the magnifying glass icon and select the name of the child from the list, or type all information in the available fields. For “Relationship,” click Son or Daughter.
4. To enter the person performing the ordinance, click the magnifying glass icon and select the name from the list. If the person performing the ordinance is from outside the ward, obtain his full legal name and priesthood office, and enter them in the fields under Person Performing the Ordinance.
5. If it is not already filled in, enter the unit number and official Church name for both the ward or branch and stake or district where the child lives.
6. Click Print to print the certificate.

Confidential Reports and Forms

Forms used in conjunction with Church disciplinary councils are called confidential forms. MLS prints five confidential forms. They are:
- Report of Church Disciplinary Action
- Report of Administrative Action
- Baptism and Confirmation Record for Readmission
- Application to the First Presidency
- Confidential Member Information Report

Note: Only the bishop can access the Confidential Member Information Report. It lists members with confidential event information recorded on their membership records. This report could help the bishop know who to encourage participating in the gospel.

There are instructions pertaining to the use of each form, located on the same screen as the Confidential Forms. To access these instructions, on the Other Resources panel, click Confidential Reports and Forms.

When you click the name of a confidential form, a screen will open where the information that goes on the form may be entered into fields. Note the following:

- For each of the Name fields, if the person is currently a member of your ward or branch, click the magnifying glass icon and select from the list that appears. This will automatically fill in the Name field and other fields in the form. If the person is not a member of your ward or branch, type the information in the fields.
- When a field has a down arrow on the right side, click the arrow and select from the list.
- For questions involving multiple options, click the circle by the correct answer.
- Complete all applicable fields and print the form.

Note: If you want to save the form and complete it later, click Save.

There is also a Confidential Member Information Report. This lists confidential actions taken with members in the ward or stake.

Create Records

Child Blessing or New Child of Record

When a baby is blessed, the ward completes a Child Blessing Record. Use this form to create a record for the child.

You may also create a record for a child under the age of eight if:

- One of the parents is a member.
- Both parents agree to create the record.

1. On the MLS menu bar, click Membership. Click Ordinances. Depending on the situation, click either Record Child Blessing or (if there has been no blessing) New Child of Record.
2. If it is not already filled in, enter the complete name, preferred name, and sex of the child. A preferred name is one the child is called that is not the legal name (such as “Bob” for “Robert”).
3. Enter the birth information (birth date, birthplace, and birth country).
4. Enter the unit number and official Church name for both the ward or branch and the stake or district where the child lives. Click Next.
5. Next to the question “Is this individual the head of household?” click No. Click the magnifying glass icon and choose the head of household from the list. Click Next.

6. If you have received permission from the parents to enter the child’s personal contact information (phone number and e-mail address), click Permission Received. If not, click Cancel, and enter only the household information.

7. Complete the phone and e-mail information (if known) as necessary. Click Next.

8. If it is not already filled in, complete Residential Address information as completely as possible. Do not complete the Mailing Address information unless it is different from the residential address. Click Next.

9. Click the magnifying glass icon and choose the father from the list. Or, if he does not live in the ward, type the information in the fields. Repeat for the mother. Click Next.

10. If you are recording a child blessing, complete the information in the window using the Child Blessing Record and click Save. Click Next.

11. Click the appropriate statement about the child’s sealing to parents. (Children born after their mother has been sealed to a husband in the temple are born in the covenant [BIC]. Children born after a mother’s sealing to the husband is canceled or after the excommunication of one of the parents are not BIC.) Complete any other necessary information and click Next.

Blessing a Child from Another Ward:
Use the same procedure for creating a record for a child in your own ward, with the following differences:

- Record the child’s head of house from the child’s home ward.
- Record either the member record number or birth date of the child’s head of house from the child’s home ward.
- Record the unit name and number of the child’s home ward.

This will cause the administrative office to send the new member record to the child’s home ward, not to your ward.

Nonmember Record
A nonmember record can be created for a person who is not a member of the Church but who has family members who are members of the Church. The nonmember record is created to record family relationships so that the nonmember can be listed with other family members. This should only be done for individuals who live in the ward boundaries.

Information about a nonmember relative will be retained on the computer with MLS. It cannot be transferred to another ward, and is not considered a membership record.

If the Nonmember is a Spouse of a Member:
The current spouse and marriage information should be recorded on the member’s record. Once the nonmember spouse information is listed on the member’s record, do the following:
1. On the MLS menu bar, click Membership. Click Individual Record.
2. Choose the name of the member who has a nonmember spouse. Click OK.
3. On the left side of the screen, click Current Spouse.
4. In the Current Spouse section, click Add Spouse to Household to automatically create the nonmember record and list the nonmember with the member spouse on the membership directories.

Note: If the Add Spouse to Household link is not available, there is either no current spouse record on the member’s record or there is already a nonmember record created for this spouse.

5. Click Close.

Note: If the nonmember spouse is male, this procedure will automatically make him the head of household.

If the Nonmember Is a Relative of a Member but Not the Spouse of a Member:
1. On the MLS menu bar, click Membership. Click Records. Click Nonmember Record.
2. Enter the complete name, preferred name, and sex of the nonmember. A preferred name is on the person uses that is not the legal name (such as “Bob” for “Robert”). Click Next.
3. Next to the question “Is this individual the head of household?” click Yes or No.
• If the nonmember is not the head of household, click the Select button and select the head of the house from the list. Click Next.
• If the nonmember is the head of household, complete the phone and e-mail information if known. Click Next.

4. Only if the nonmember is the head of household, complete the Residential Address information as completely as possible. Do not complete the Mailing Address information unless it is different from the residential address. Click Next.

5. Review the summary, and then click Close. Click Save.

   Note: This will create the nonmember record and assign it to the correct household if the nonmember is not the head of household. Continue with these instructions if the nonmember head of household has additional members to add to the household. Otherwise this task is completed.

6. On the MLS menu bar, click Membership. Click Household Record.

7. Choose the newly created nonmember head of household from the list and click OK.

8. In the Household Members section, click Add Member.

9. Choose the name of the nonmember, and click OK.

10. In the Members to Include section, click the boxes of any additional members of the household that should be included. Click Next.

11. Review the summary, and then click Save.

12. The new household structure will be shown on the nonmember’s household screen. Click Close.

Out of Unit Member Record

An Out of Unit Member Record is sometimes confused with an Out of Unit Administrator in MLS. The Out of Unit Administrator is a stake clerk or other designated person who has administrator rights in ward MLS. This enables him to log on and help out the ward in emergency situations. This is not what we are talking about.

The Out of Unit Member Record is for a person who does not actually live in your ward, but who performs some calling or function in your ward. Good examples are the bishop of a Young Single Adult ward or a missionary serving as the president of a branch. In these cases, the record of the member remains in his home ward. However, you can create an Out of Unit Member Record so he will appear on lists and can be given MLS rights.

Create and Out of Unit Member Record:
1. Get an IOS of the member from the member’s home ward.
2. In MLS, go to the Membership Records panel and click More.
3. Go to the Create Records panel and click Out of unit member record.
4. Using the IOS, fill in all the fields on the screen. Click Close. Click Save.

Give User Rights to the Out of Unit Member:
1. First, create an Out of Unit Record (see above)
2. In MLS, go to the panel with the ward name and click System Options.
3. On the left side of the screen, click Users.
4. Click Add User.
5. Select Member of Unit. Never select “Out of Unit Administrator” for an Out of Unit Member.
6. Click Select and choose the Out of Unit Member from the list.
7. Fill in the other information and click the boxes beside the rights you want to give him or her.
8. Click Save.

Home and Visiting Teaching

The home teaching and visiting teaching screens are very similar but not identical. The instructions below are for home teaching. When instructions for visiting teaching are different, they will be noted inside parentheses. To record home or visiting teaching and print accurate reports, you must:

• Create districts and assign district supervisors.
• Create companionships and add families (or sisters) to be taught.
• Record visits (or contacts).
Creating Home (or Visiting) Teaching Districts and Assigning District Supervisors

1. On the MLS menu bar, click Organizations. Click HT (or VT) Organization. Click HT (or VT) Districts.
2. On the Show for Organization field, click the down arrow and select the organization you want to create a district for.
3. In the Home Teaching Districts area, click Add. A window appears.
4. In the Organization field, click the down arrow, and select the organization you want to create a district for.
5. Click Select. From the list, select the person you want to be a district supervisor. Click Save.
6. In the Date Sustained field, enter the date this person was sustained as district supervisor (optional).
7. Click Add.

Creating Home (or Visiting) Teaching Companionships and Assigning Families (or Sisters) to Teach

1. On the MLS menu bar, click Organizations. Click HT (or VT) Organization. Click HT (or VT) Companionships.
2. In the Show for Organization field, click the down arrow, and click the organization you want to add companionships to.
3. In the Home Teaching (or Visiting Teaching) Organization and District area, click Select District.
4. In the column for the correct month, click the check box next to each family that was visited during the month. (For visiting teaching, click the type of contact made with each sister.)
5. When finished adding companionships, click Save & Next to add another companionship, or click Save & Close to exit.

Recording Home Teaching Visits (or Visiting Teaching Contacts)

1. On the MLS menu bar, click Organizations. Click HT (or VT) Reporting. Click Enter HT Visits (or Enter VT Contacts).
2. In the Show field, click the down arrow, and click the way you want the families (or sisters) displayed (All or Unassigned).
3. Click the name of the priesthood holder (or sister) you want to assign to a companionship. Click OK.
4. Repeat steps 6 through 9 for the other member of the companionship.
5. Add families (or sisters) for the companionship to teach (see below).

Add Families (or Sisters) for This Companionship to Teach:

1. While still on the screen where you added the companionship, in the Households (or Sisters) Taught by This Companionship section, click Add.
2. In the Show field, click the down arrow, and click the way you want the families (or sisters) displayed (All or Unassigned).
3. Click the name of a family (or sister) you want to assign to this companionship. Click OK.
4. Repeat steps 1 through 3 for other families (or sisters) you want to assign to this companionship.
5. When finished adding companionships, click Save & Next to add another companionship, or click Save & Close to exit.

Record Visits or Contacts for Previous Months:

1. In the Visits (or Contacts) column, click the percentage. A window will appear.
2. In the Visits (or Contacts) column of the window, click the box next to each month the family was visited. (For visiting teaching, click the type of contact that was made for each month.)
3. Click Save.

**Moving Records**

**Moving Records into the Ward**
1. On the MLS menu bar, click Membership. Click Request Household Records or Request Individual Record.
2. To choose the sex of the head of house or individual, click Male or Female.
3. Complete the full name, birth date, and (if known) the member record number.
4. If the head of house or member is female, complete the maiden name information.
5. Enter the birth date of the head of house or individual and his or her record number (if known).
6. Complete the prior unit information if known. At the bottom of the screen, click Next.
7. Record the personal telephone number and an e-mail address for the individual, if known. Household records will not require this.
8. Record the household telephone number and e-mail address where all members of the household could be contacted. Click Next.
9. If the new residential address is known, click Yes. Complete the information listed under New Residential Address. Click Next.
10. Review the summary of the move-in information. At the bottom of the screen, click Close. Click Save.

**Moving Records out of the Ward**
1. On the MLS menu bar, click Membership. Select Move Household Records Out or Move Individual Record Out.
2. Click the name of the individual or head of household you want to move. Click OK.
3. Enter the information for the ward and stake where the individual or family is moving to if known. If your bishop would like contact with the new bishop, click Yes. Click Next.
4. If you are moving a household, a screen will appear showing each record in the household. This screen will not appear if you are moving an individual record. Click Next to move to the next screen.
5. For the question “Will this individual be the new head of household?” click Yes or No. If you are moving the record of an individual who will not be the head of household, complete the information about head of household (household records will not require this information). Click Next.
6. Record the personal telephone number and an e-mail address for the individual, if known. Household records will not require this.
7. Record the household telephone number and e-mail address where all members of the household could be contacted. Click Next.
8. If the new residential address is known, click Yes. Complete the information listed under New Residential Address. Click Next.
9. If the new address is unknown, click No. Type any contact information that might be helpful in the Contact Information box. Click Next.
10. Review the summary of the move-out information. At the bottom of the screen, click Close. Click Save.

**Other Membership Tasks**

**Canceling a Record**
You can cancel a record if (1) it is a duplicate record or (2) it is a record of an unbaptized child who has reached the age of 18 and you have permission from the stake president.
1. On the MLS menu bar, click Membership. Click Records. Click Cancel Record.
2. Click At least 18 years old and not baptized or Duplicate Record.
3. If it is a duplicate record, enter the correct record number to keep, or click Select, and choose the record number to keep from the list.
4. Click Close. Click Save.
Priesthood Ordination

Aaronic Priesthood ordinations are authorized by the bishop. Melchizedek Priesthood ordinations are authorized by the stake president. The ward clerk records Aaronic ordinations using MLS. Either the stake clerk or the ward clerk can record the Melchizedek ordination, but it should generally be the stake clerk. The following instructions are for the ward clerk. If the stake clerk is recording a Melchizedek Priesthood ordination, see “Stake Recording a Melchizedek Priesthood Ordination” below.

Ward Recording a Melchizedek Priesthood Ordination:
1. On the MLS menu bar, click Membership. Click Ordinances. Click Record Priesthood Ordination.
2. Type the name of the person receiving the ordination and press Enter, or find the name on the list and click OK.
3. Using information from the Aaronic Priesthood Ordination Record or the Melchizedek Priesthood Ordination Record, select the priesthood office the member was ordained to. Enter the date the ordination occurred.
4. If the person who performed the ordination is a member of the ward, click the magnifying glass icon, and choose his name from the list that appears. If not, enter the information. Click Save.
5. Click Close. Click Save.
6. A window will appear asking if you would like to print a certificate. If you click Yes, you will be able to print the certificate.

Stake Recording a Melchizedek Priesthood Ordination:
1. On the MLS menu bar, click Membership. Click Individual Record. Select the name of the person who was ordained from the list, and click OK.
2. On the left side of the screen, click Ordinances.
3. In the Priesthood Ordinations area, click Add Ordination.
4. Using information from the Melchizedek Priesthood Ordination Record, select the priesthood office the member was ordained to. Enter the date the ordination occurred.
5. If the person who performed the ordinance is a member of the ward, click the magnifying glass icon and choose his name from the list that appears. If not, enter the information. Click Save.
6. Click Close. Click Save.

Recording a Death
1. On the MLS menu bar, click Membership. Click Records. Click Death of Member.
2. Type the name of the person who died and press Enter, or find the name on the list and click OK.
3. In the Death Date field, enter the date in the format shown on the screen.
4. Click Close. Click Save.

Special Requests
Special Requests is an option used to make membership record changes when they cannot be made using the options already available in MLS.
1. On the MLS menu bar, click Membership. Click Records. Click Special Requests.
2. On the list that appears, click the name of the member for whom you want to make record changes. Click OK.
3. In the space provided, type a description of the changes you would like to make to the membership record you have selected. Click Close. Click Save.

After the administrative office receives the request, it will be sent to the right organization for consideration. The ward will receive an MLS message after the change has been made or denied.

Temple Recommends

Activating Temple Recommends

The following instructions are for stakes in temple districts that use temple recommends with a bar code. If your stake does not use temple recommends with a bar code, ignore these instructions.

Stakes that have temple recommends with a bar code follow these steps:
• The bishop or one of his counselors interviews the member and issues the recommend.
• After the stake presidency member interviews the member, a copy of the
recommend is scanned into MLS by the stake (see procedure below).

**Stake MLS Procedure for Activating Recommends:**
1. On the MLS menu bar, click **Membership**. Click **Temple Recommends**. Click **Activate Recommends**.
2. Find the name of the member who is on the recommend by scrolling or by using the Find Member in List field. Next to the member’s name, click **Activate**.
3. In the window that appears, type the last four numbers of the membership record number as shown on the recommend.
4. Scan the bar code to add the recommend number to MLS. (You can also type the number, which is located just above the bar code.)
5. Click the arrows on the issued date field to choose the month and year the bishopric issued the recommend.
6. Click **Continue**.
7. Check the information that appears in the window to make sure it is the same as the information on the recommend.
8. If it is correct, click **Activate**. If it is not correct, click **Back**, and make corrections.
9. When finished activating recommends, go to the panel with the stake name and click **Send/Receive Changes**. Do not delay sending the changes.

**Changing Temple Recommend Status**

It may become necessary to change the status of a temple recommend if it is lost or stolen, or if the bishop and stake president determine the status should be changed. The stake president must approve changes to the status of temple recommends. The status of a recommend cannot be changed on the ward level.

**Stake MLS Procedure for Changing Recommend Status:**
1. On the MLS menu bar, click **Membership**. Click **Temple Recommends**. Click **View/Edit Recommends**.
2. Find the name of the member whose recommend status has changed. Next to the member’s name, click **Edit**.
3. On the window that shows the member’s temple recommend information, click **Edit**.
4. In the Recommend Status field, click the **down arrow**, and click the new status of the recommend (choices are **Canceled** and **Lost or Stolen**). Click **Save**.
5. Click **Yes** to verify that you want to cancel the recommend.

**Updating Membership Records**
1. On the MLS menu bar, click **Membership**. Click **Individual Record**.
2. Click the name of the individual whose record you want to update. Click **OK**.
3. On the left side of the screen, click the category of information you want to update. The choices are:
   - Individual personal information
   - Household members
   - Contact information
   - Address
   - Parents
   - Ordinances
   - Temple and mission
   - Current spouse
   - Children
4. Use links on the screen that allow you to change information (such as Edit, Remove, and Add). These links open windows where you can change information.
5. When you are finished, click the **File** drop-down menu, and click **Send/Receive Changes**.

**MLS Messages**

MLS has the capability to send messages from wards to stakes and the administrative office. Messages can also be sent from the stake to all wards and from the stake to the administrative office. All units can receive messages from the administrative office. Ward-to-ward communication is not yet possible.

**Reading a Received Message**
1. On the MLS menu bar, click **Reports/Forms**. Click **Messages**.
2. In the Received Messages section, click the subject of one of the unread messages. (Unread messages have an icon that looks like an unopened envelope.)
3. After you have read the message, you may do one of the following:
   • Reply to the message. Click **Reply**. After you write your reply, click **Save**. The message will be sent the next time you use **Send/Receive Changes**.
   • Forward the message. Click **Forward**. Type an explanation of what the message is for, if wanted. Click **To** at the top of the screen and choose a new destination for this message. Click **Save**.
   • Delete the message. Click **Delete**, and then click **Yes**.

Creating and Sending a Message
1. On the MLS menu bar, click **Reports/Forms**. Click **Messages**. At the bottom of the screen, click **Create Message**.
2. In the Type field, click the desired button (**Finance**, **Membership**, **Stake**, or [for stakes] **Unit to Unit**).
3. If you selected **Stake** or **Unit to Unit**, click **Address Book**, and choose where you want to send this message by clicking the box by the unit leader’s name. If the unit leader’s name is not listed, click **Add** in the upper right corner, and input the name.
4. In the From field, enter your name (if it is not already there).
5. In the Subject field, enter a brief subject heading.
6. In the Message area, type the message. Click **Save**. The message will be sent the next time you use **Send/Receive Changes**.

Forms
Officers Sustained
The Officers Sustained form is completed before a stake or ward conference and then read from the pulpit during the conference so that members may sustain their stake or ward officers.
1. On the MLS menu bar, click **Reports/Forms**. Click **Officers Sustained Forms**. Click **Print Form**.
2. From the list that appears, click the Officers Sustained form that fits your unit. The choices are:
   • Officers Sustained—Branch in Mission
   • Officers Sustained—Branch in Stake
   • Officers Sustained—District
   • Officers Sustained—Stake
   • Officers Sustained—Ward
3. Click **OK**.
4. On the screen that appears, fill in the fields if they are blank or incorrect. However, if there is no one called for a particular position, leave the field blank.
5. When finishing filling in the fields, click **Print** at the bottom left of the screen.

Ordinance Record Forms
Ordinance record forms are used to record information about an ordinance so that the information can later be used to update the member record or to print a certificate.
1. On the MLS menu bar, click **Reports/Forms**. Click **Ordinance Record Forms**.
2. From the list that appears, click the record form for the ordinance that will be performed. The choices are:
   • Aaronic Priesthood Ordination Record
   • Baptism and Confirmation Record
   • Child Blessing Record
   • Melchizedek Priesthood Ordination Record
3. Click **OK**.
4. On the screen, fill in all fields that can be completed before the ordinance is performed. The others will be filled in by hand after the ordinance is performed.
5. When finished filling in the fields, click **Print** at the bottom right of the screen.
6. If you are in a country that requires consent from a parent for some ordinances, make sure the parent or parents sign the record form before proceeding.
7. The stake or ward representative takes the form to the ordinance and completes the form by hand. The representatives are:
   • For eight-year-old baptisms, the ward clerk or an assistant clerk.
   • For a child blessing, the ward clerk or an assistant clerk.
   • For an Aaronic Priesthood ordination, the ward clerk or an assistant clerk.
   • For a Melchizedek Priesthood ordination, the stake clerk or any stake assistant clerk (this person should also make sure the stake clerk records the ordination in MLS).
8. For all but Melchizedek Priesthood ordinations, the representative gives the completed form to the ward clerk (if the ward clerk was not the one to fill it out) so that he may enter the ordinance information in MLS.

9. For Melchizedek Priesthood ordinations, the representative gives the completed form to the stake clerk (if the stake clerk was not the one to fill it out) so that he may enter the ordinance information in MLS.

Reports and Directories

Action and Interview List

The action and interview list is a report showing members who need to be interviewed and other members who fall into special categories, such as potential missionary couples. Some of the interviews may be done by the bishop’s counselors, while others may be done only by the bishop himself.

The lists are:

- Children approaching baptism
- Baptized but not confirmed
- Unbaptized members
- Overdue Aaronic Priesthood ordinations
- Young men approaching missions
- Men who have not served a mission
- Potential missionary couples
- Bishop’s youth interviews
- Bishopric counselor youth interviews
- Young single adult interviews

To print the Bishopric Action and Interview List:

1. On the MLS menu bar, click Reports/Forms. Click Other Lists. Click Action and Interview List.

2. In the Sections to Show field, click the down arrow and select which list or lists you want to view. In addition to the list above, you can also choose:
   - All sections
   - All regular interviews
   - All sections except regular interviews

3. To print the selected lists, click Print at the bottom of the screen.

Directories

To reach the member directories, on the MLS menu bar, click Reports/Forms. You may select Telephone and E-mail Directory, Abbreviated Directory, or Directory of Members.

Each of the three types of member directories serves a different purpose.

Telephone and E-mail Directory:

The Telephone and E-mail Directory lists the head of household and spouse and their telephone number. It is the most simple of the three directories. Note the following:

- To display the Telephone and E-mail Directory, on the MLS menu bar, click Reports/Forms. Click Telephone and E-mail Directory.
- To bring a name to the top of the list, enter a name in the Find Household field.
- To list the directory by telephone number (low to high), click the Phone column header.
- To list the directory by e-mail address (alphabetically), click the E-mail column header.
- (Stakes only) To list the directory by ward, click the Ward column header.
- To resize columns, place the mouse pointer between column heads, click and hold, and then drag left or right.
- To print the directory, click Print at the bottom of the screen.

Abbreviated Directory:

The Abbreviated Directory lists the head of household and the spouse, the telephone number, the address, and the e-mail address. This is the directory most members use to interact with other members of the ward. Note the following:

- To display the Abbreviated Directory, on the MLS menu bar, click Reports/Forms. Click Abbreviated Directory.
- (Stakes only) In the Unit field, click the down arrow, and choose which ward or branch you want on the directory (you may also choose All).
- To bring a name to the top of the list, enter a name in the Find Household field.
- To change the order of information in a column, click the column header.
• To resize the columns, place the mouse pointer between column heads, click and hold, and then drag left or right.
• To print the Abbreviated Directory, click **Print** at the bottom of the screen.

**Directory of Members:**

The Directory of Members lists households. It shows the name of each member of the household, the address, and the telephone number. This directory is sorted by head of household. The Directory of Members may be particularly helpful to priesthood and auxiliary leaders. Note the following:

• To display the Directory of Members, on the MLS menu bar, click **Reports/Forms**. Click **Directory of Members**.
• (Stakes only) In the Ward field, click the **down arrow** and choose which ward you want on the directory (you may also choose **All**).
• To bring a household name to the top of the list, enter a name in the Find Household field.
• To change the items shown on the directory, click **Customize**. Click or unclick the items you want to include on or remove from the directory. Click **OK**.
• To resize columns, place the mouse pointer between column heads, click and hold, and then drag left or right.
• To print the Directory of Members, click **Print** at the bottom of the screen.

**Priesthood and Auxiliary Class Rolls and Lists**

*Adding Classes:*

To show the links to the various quorums, groups, and auxiliaries, on the MLS menu bar, click **Organizations**. Click the name of the organization you want.

For all priesthood organizations except high priests, you can add a quorum. This is equivalent to adding a class. You must have the approval of the proper ward or stake leader to add a quorum. After you click the name of the priesthood organization (elders, priests, and so forth), you will see an **Add Quorum** button at the bottom of the screen.

For most auxiliaries it is possible to add a class. For auxiliaries such as Young Women and the Relief Society, after you click the name of the auxiliary, you will see an **Add Class** or **Add Group** button at the bottom of the screen.

For Sunday School and Primary, there is no button. However, after you click either Sunday School or Primary, there will be a section on the screen called “Classes.” In this section you will find an **Add Class** link.

**Class Rolls and Lists:**

On the MLS menu bar, click **Organizations**. Select the name of the organization you want to print a roll or list for.

For all priesthood quorums and groups and all auxiliaries except Sunday School and Primary, after you click the organization you want, there will be a section called “Members” for each class on the screen. In this section there is a **Print** link.

Click the **Print** link, and a window will appear that allows you to choose the kind of roll or list you will print. The choices are:

• Attendance Roll
• Birthday List
• Standard Class List
• Abbreviated Class List
• Phone Number List

For Sunday School and Primary, you must first click **Class Members** on the left side of the screen. Then you can find the “Members” section and click the **Print** link. In the window where you print rolls and lists:

1. In the List Type to Print field, click the **down arrow**. Click the kind of roll or list you want to print.
2. In the “Options” section of the window, select the options you want for this roll or list.
3. At the bottom of the window, click **Print**.

**Callings by Organization Report**

1. On the MLS menu bar, click **Organizations**. Click **Reports/Tools**. Click **Callings by Organization**.
2. In the Show field, click the **down arrow**. Click the organization you want to print a report for. To print a report for all organizations, click **All**.
**Note:** Even if you click All, the report will show only those organizations that have callings recorded.

3. At the bottom of the screen, click **Print**.

### Quarterly Report

Complete the Quarterly Report during the first month of a new quarter, using information from the last month of the previous quarter. For example, in January, gather and enter information about December from quorum and auxiliary secretaries or leaders and from other clerks. Complete the report before the 15th of the first month of the quarter. Quarterly reports are due by January 15, April 15, July 15, and October 15.

1. On the MLS menu bar, click **Reports/Forms**. Click **Reports/Tools**. Click **Quarterly Report**.
2. On lines 2, 4, 6, 8, 10, 11, 13, 15, 17, 19, 21, 24, and 25, fill in the information gathered from quorum, group, and auxiliary secretaries and leaders and from other clerks and the bishopric. On lines 24 and 25, click **Edit** to complete the information.
   - Calculate the average sacrament meeting attendance by adding the total number attending each sacrament meeting during the last month of the quarter and dividing by the number of meetings held. Count all persons attending sacrament meeting, including members, nonmembers, visitors, missionaries, and babies. Do not count any members not in attendance, such as members serving missions, members performing other Church assignments, or members attending other wards.
   - For class attendance (priesthood, Relief Society, Young Women, and so on), count each person who attended at least once during the last month of the quarter.
3. To print a list of members corresponding to any given line of the report, click the line title in blue text. To print the list, click **Print**.
4. If you want to read an explanation for any line, click the **Question Mark** icon on that line.
5. To transmit the Quarterly Report to the stake and the administrative office, click **Send/Receive Changes** on the panel that contains your unit’s name.

### New Member Report

The New Member Report shows whether each convert of the last 24 months has:

- Been assigned home teachers.
- Received the priesthood (for males 12 years or older).
- Been assigned a responsibility or calling.

This report can be used in priesthood executive committee or ward correlation council meetings to discuss the progress of new members of the Church living in the ward boundaries.

1. On the MLS menu bar, click **Reports/Forms**. Click **Reports/Tools**. Click **New Member Report**.
2. Complete the report. The fields in the New Member Report are completed as follows:
   - **Name, Sex, Age, Confirmed**—Information provided by the member record after it is received by MLS.
   - **Priesthood**—Information appears in this column after the clerk records a new male member’s priesthood ordination in MLS.
   - **Home Teachers**—Home teachers are shown in this column after they are entered in the home teaching section of MLS by the appropriate quorum or group leadership.
   - **Responsibility or Calling**—Information appears in this column after the clerk records the new member’s calling in MLS.
3. To print the New Member Report, click the **Print** button at the bottom of the screen.

### Donor Statements

Each donor should be given a year-to-date statement a month before tithing settlement. Each donor should also be given a year-end tax-valid statement after the year ends. Both kinds of statements can be printed from the same screen.

1. On the MLS menu bar, click **Finance**. Click **Finance Reports**. Click **Donor Statements**.
2. If necessary, use the Fiscal Year field to select the appropriate year.
3. Use the Type of Report field to select the report you want.
4. To print a statement for everyone in the household, click the **By Household** box so that a check mark appears.
5. To select the donor statements to print, click the box next to the name of each donor. To select all donors, click Select All.
6. To print the statements, click the Print button at the bottom of the screen.

Individual Ordinance Summaries (IOS)

Members of the Church should not be given copies of their membership records. However, any member can be given a copy of his or her Individual Ordinance Summary (IOS). This document has most of the same information as the membership record, including all ordinances performed and the date they were performed.

Members should be given a copy of their IOS once a year during tithing settlement so they may check the information for accuracy. Any mistakes on the IOS should be reported to the ward clerk.

Members who want to register for the stake and ward websites will also need a copy of the IOS. The member number and confirmation date are required to register. Both of these are found on the IOS.

1. On the MLS menu bar, click Membership. Click Print Records. Click Individual’s IOS.
2. To select summaries to print, click the box next to the member’s name. To select all summaries to print, click Select All.
3. Click Print Selected IOS Reports at the bottom of the screen.

Custom Reports

Custom reports can generate lists of members using a wide range of criteria. Examples of possible custom reports are:
- Members who served in the same mission.
- Members with a particular talent, such as playing the piano.
- Members who do cabinet work.

A leader might use multiple criteria, such as all high priests with a particular mission language. Priesthood leaders may use these custom reports to select members to serve in a particular calling.

The Custom Reports screen allows you to use many criteria that are already in the MLS records, such as confirmation date, marriage date, and endowment status.

Create Custom Reports:
1. On the MLS menu bar, click Reports/Forms. Click Reports/Tools. Click Custom Reports.
2. Click Add Report.
3. In the Name field, enter the name you want to call this report (such as Returned Missionary). In the Description field, add a short description if needed.
4. Click Add Criteria.
5. In the window that appears, click on a criterion for your report. (For this example, we would select is and Returned Missionary.
6. Use the Compare Operation and Value fields to define your criteria. (For this example, we would select is and Returned Missionary.
7. If necessary, add a value by clicking More. Repeat step 6 as needed.
8. Add as many criteria as needed to identify the members who will be on the custom report. For example, if you are looking for Melchizedek Priesthood holders who can conduct music, you would need two criteria lines.
9. When finished adding criteria, click Next.
10. In the Columns section, click the check box next to each item you want in a column on your report. Use the Move Up and Move Down buttons to arrange the order of items in a column.
11. In the Set Column Widths section, click Select. To adjust column sizes, place the mouse arrow between column headings, click and hold, and drag the edge of the column right or left. When finished, click Close.
12. Click Close. Click Save.

Use Custom Criteria:
You can also create your own custom criteria to use in these reports. To create custom reports with your own custom criteria, you must do two things:
1. Complete the Custom Talents and Interests fields in the system options.
2. Complete the Custom Member Fields for each active member of your ward.

Complete the Talents and Interests Fields:
1. On the panel with your unit name, click System Options. On the left side of the screen, click Members.
2. The Talents and Interests panel will appear on the screen, containing talents and interests that
Complete the Custom Member Fields for Each Active Member:
1. On the MLS menu bar, click Membership. Click Custom Member Fields.
2. On the window that appears, click the name of the member for whom you want to add talents and interests. Click OK.
3. In the upper right corner of the screen, click Add.
4. On the Add Talent or Interest window, click a talent or interest you want to appear on this member’s record. Click OK.
5. When finished, click Close.
6. Repeat this procedure for every talent you want to list for every member.

Membership Record Validation Report
This report lists errors and warnings found in the membership records assigned to your unit. Make corrections to these errors and warnings as soon as possible. If a record has an error (not a warning), no other changes may be made to that record until the error is fixed.
1. On the MLS menu bar, click Membership. Click Membership Validation Report.
2. Click the name of the person who has the error or the warning.
3. On the member record, correct the information that has the error or warning.
   Note: If there is no way to fix the error or respond to the warning, you may click Ignore at the end of the line; however, all attempts to correct the problem should be made before resorting to this.
4. When finished making corrections, click Close.

Seminary and Institute
Seminary Enrollment Progress
This report lists the youth of seminary age. It helps priesthood leaders to “encourage all youth of the appropriate age (generally 14-18) to participate in seminary” (Handbook 1, 1.11.4). It may also be printed and given to seminary personnel and stake supervisors to assist them in their assignments.
1. In the Other Resources pane, click Seminaries and Institutes, click Seminary Enrollment Progress.
2. Select the Beginning Age, Ending Age, and School Year fields (Current Year or Next Year).
3. For each youth on the list, update the information in the Seminary Year column. The down arrow will permit the user to select the youth’s year in seminary from the list.
4. Click the magnifying glass icon and choose the school the youth attends or will attend based on the School Year field set in #2 above. Then click OK. If the school is not on the list, click the Add button and add the needed information.
5. When information for all youth has been entered, click the Print button at the bottom of the screen. This report may be provided to the Seminary representatives.

Released-Time Preregistration
This form is used to collect and enter information regarding the upcoming school year (year in seminary and school attending). As this information is gathered and entered into MLS, ward leaders are able to receive regular updates to each seminary student’s enrollment, attendance, and completion status.
1. In the Other Resources pane, click Seminaries and Institutes, click Released-Time Preregistration.
2. Select the Beginning Age, Ending Age, and School Year (Current Year or Next Year).
3. Click the check box next to the name of each youth for whom a form is needed (or click Select All at the bottom of the screen to print a form for all youth).
4. At the bottom of the screen, click the Print button.
5. Ask a parent or guardian to complete and sign the form.
6. Use the information on the collected forms (school name and grade) to complete or update the fields in the Seminary Enrollment Progress screen.
7. Give the forms to the seminary representative or to another representative designated by the stake.

Seminary Attendance Report
The Seminary Attendance Report provides regular updates regarding the seminary student’s enrollment, attendance, and completion status. The report is updated each time you use Send/Receive Changes. Bishoprics and youth leaders should review the report periodically. The report lists youth that have had their ‘Seminary Year’ designated in the Seminary Enrollment Process screen.

1. In the Other Resources pane, click Seminaries and Institutes, click Seminary Attendance Report.
2. At the bottom of the screen, click the Print button.

Seminary Graduation Report
The Seminary Graduation Report is provided to help bishoprics with seminary graduation. The report lists the names of youth that have met the academic requirements necessary to graduate from Seminary. This list can be used to help indicate to the bishop the individuals that need a worthiness interview before a seminary graduation diploma can be presented. This list is updated each time you use Send/Receive Changes.

1. In the Other Resources pane, click Seminaries and Institutes, click Seminary Graduation Report.
2. At the bottom of the screen, click on the Print button.

In order to graduate from seminary, students must:
- Complete certain academic and attendance requirements.
- Have a priesthood worthiness clearance. *(Handbook 1, 11.2.3.)*

Youth listed on this report have met the academic requirements for graduation. The bishop or an assigned counselor determines the worthiness of each candidate prior to graduation. If the bishop needs additional time beyond seminary graduation to resolve worthiness issues, the diploma or certificate should be kept by the bishop. It may then be awarded by the bishop when appropriate.

Institute Enrollment Progress
“Weekday gospel study classes can help young single adults strengthen their faith and testimonies. All young single adults should be encouraged to attend institute classes, whether they are attending school or not.” *(Letter from the First Presidency dated April 21, 2011)*

This worksheet is used by stake and ward leaders to counsel together to help young single adults enroll in institute and to report on those efforts. Stake and ward leaders work closely with local Institute personnel in an effort to invite each individual to enroll. The following general schedule should be followed as we invite enrollment in institute.

1. Three months before the beginning of the post-secondary school year this worksheet should be printed.
2. Ward leaders discuss those individuals on the list and make assignments for inviting each young single adult to enroll in institute.
3. One month before the beginning of the post-secondary school year;
   a. Enter the individual’s location or school information into MLS.
   b. Provide a copy of this worksheet to the stake leadership.
   c. Provide a copy of this worksheet to the institute representative.

Identification of the institute location or school attending enables leaders and institute personnel to encourage participation in institute where the young single adult is living.

1. In the Other Resources pane, click Seminaries and Institutes, click Institute Enrollment Progress.
2. Enter the institute location or school attending for each young single adult, if known. Click the magnifying glass icon, choose the location or school from the list, and click OK. If the institution is not on the list, click Add and add the needed information.
3. Click Save.
4. At the bottom of the screen, click the Print button.
5. Use this worksheet to record invitations to young single adults to attend institute and to counsel with others on the best ways to encourage participation. This report should be provided to Institute representatives.

**Institute Attendance Report**
The Institute Attendance Report is updated periodically by Seminaries and Institutes and downloaded to MLS when you use Send/Receive Changes. Bishoprics and other ward leaders should review the report periodically to monitor each young single adult’s participation in institute.
1. In the Other Resources pane, click Seminaries and Institutes, click Institute Attendance Report.
2. At the bottom of the screen, click the Print button.

**Institute Graduation Report**
The information on the Institute Graduation Report is provided by Seminaries and Institutes and downloaded to MLS when you use Send/Receive Changes. The report lists the names of young single adults that have met the academic requirements necessary to receive a certificate or graduation diploma from Institute. This list can be used to help indicate to the bishop which young single adults need a worthiness interview before an institute certificate or diploma can be presented.
1. In the Other Resources pane, click Seminaries and Institutes, click Institute Graduation Report.
2. At the bottom of the screen, click on the Print button.

In order to graduate from institute, students must:
- Complete certain academic requirements.
- Have a priesthood worthiness clearance. *(Handbook 1, 11.2.3)*

The students who appear on this report have met the academic requirements for graduation. The bishop or an assigned counselor determines the worthiness of each candidate prior to graduation. If the bishop needs additional time beyond institute graduation to resolve worthiness issues, the diploma or certificate is kept by the bishop. It could then be awarded by the bishop when appropriate.

---

**Users and Rights**

**Assigning Rights**
Each MLS user is assigned rights by the MLS administrator (normally the ward clerk). Assigning these rights causes certain information to appear in the MLS program when the user logs in. For example, only those users with administrative or finance rights can enter donations in MLS. Other users do not see the option to enter donations.

Rights can be assigned or removed. Rights are assigned when a new user is recorded in MLS. For example, a new finance clerk would be assigned finance rights as part of the process of recording him as a user.

Rights can also be changed later by the administrator.

**Adding Users**
1. On the panel containing the unit name, click System Options. The Users section of system options will appear.
2. On the screen, click Add User. *Note:* If you want to change rights for an existing user, click the user’s name on this screen.
3. Click either Member of Unit or Out-of-Unit Administrator. An out-of-unit administrator is someone from the stake (such as the stake technology specialist) who can gain access to help fix problems in MLS.
4. In the User Name field, enter the user name for this member (example: John Jones).
5. Click Select to the right of the member field.
6. Choose the member name from the list, and click OK.
7. In the New Password field, have the member enter the password he or she will use to log in to MLS.
8. In the Retype New Password field, have the member enter again his or her new password.
9. Click the check box next to the set of rights to MLS that this user will have.
   - **Admin**—Bishop and ward clerk
   - **Finance**—Clerk assigned to finances, bishopric members
   - **Edit Membership**—clerk assigned to membership records
• **View Membership**—Bishopric members
• **Organization**—Bishopric members, auxiliary and quorum leaders, and secretaries.
• **View Recommends**—Bishopric members and ward clerk
  **Edit Recommends**—(Stake only) Stake presidency members, stake clerk, and assistant stake clerks assigned to activate or edit temple recommend information.

10. Click **Save**.

**Passwords**

Each MLS user should have his or her own password. Do not assign generic or group passwords to be used by more than one person.

A password is initially assigned by the MLS administrator when a user is added to the system (see previous column). Each user should change his or her password periodically.

Passwords must be at least 8 characters long and contain at least one letter and one number. To change a password, do the following:

1. On the panel containing the unit name, click **Change Password**.
2. In the Old Password field, enter the password you are currently using.
3. In the New Password field, enter the password you want to begin using.
4. In the Retype New Password field, enter the same password you entered in step 3.
5. Click **Save**.
Appendix A
Member and Leader Services (MLS)
Membership and Financial Policies

Contents

Overview .................................................. A-2
Duties of Stake and Ward Clerks ......................... A-2
Overview of MLS ........................................ A-2
System Log In ............................................ A-2
Security ..................................................... A-2

General MLS Information ................................ A-3
Urgent Tasks .............................................. A-3
Sorting Reports ........................................... A-3
Stake Data Transfer ...................................... A-3
Unit-to-Unit Messaging ................................ A-3

Membership Records ................................... A-3
Confidential Nature of Member Records ............... A-3
Duties of the Clerk Assigned to Member Records . A-4
Getting Help .............................................. A-4
Members of Record ....................................... A-4
Receiving Membership Records ....................... A-4
Membership Record Updates ........................... A-5
Out-of-Unit Member Records ........................... A-5
Nonmember Records ..................................... A-5
Blessing a Child from Another Ward ................ A-5
Convert Records ......................................... A-5

Moving Membership Records .......................... A-6
Requesting Membership Records ....................... A-6
Moving Member Records from the Ward ................ A-6
Full-Time Missionaries ................................ A-6
Youth Away from Home ................................ A-6
Members with Leadership Assignments .............. A-6
Members in the Military ................................ A-6

Miscellaneous Membership Policies ................ A-6
Certificates and Forms ................................ A-6
Custom Reporting ........................................ A-6
Data Export .............................................. A-7
Duplicate Membership Records ....................... A-7
Full-Time Missions ..................................... A-7
Head of Household ...................................... A-7
Marriages .................................................. A-7
Name Changes .......................................... A-7
Not Accountable ......................................... A-7

Organizations ............................................. A-8
Prior Marriage Information ............................. A-8
Sensitive Information .................................... A-8
Software Changes ........................................ A-8
Temple Ordinance Updates ............................. A-8

Finances ..................................................... A-8
Budget Allowance ........................................ A-8
Tithing and Donations .................................. A-9
Fast-Offering Donations ................................. A-9
Using the “Other” Category ............................... A-9
Paying for Online Store Purchases through the ward or branch ........................................ A-9
Recording Tithing and Donations ....................... A-10
Making the Bank Deposit ................................ A-10

Banking Policies .......................................... A-11
Handling Returned Checks ............................... A-11
Stopping Payment on a Check ......................... A-11
Voiding a Check .......................................... A-11

Tithing Settlement ......................................... A-12
Tithing Status Definitions ............................... A-12
Special Cases ............................................. A-12
Ward Division or Boundary Change .................. A-13
Discontinued Wards ..................................... A-13
Stake Procedures ........................................ A-13

Miscellaneous Financial Policies ..................... A-14
Checks ...................................................... A-14
Computer Failure ......................................... A-14
Discontinued Ward ........................................ A-15
Missionary Financial Support for Wards on the Equalized Payment Program ............ A-15
Outstanding Checks ..................................... A-17
Property Tax Exemption ................................ A-17
Records Management .................................... A-18
Reimbursements ......................................... A-18
Stake Income ............................................. A-18
Tithing and Other Offering Amounts Are Confidential ........................................ A-18
Tithing and Other Offerings Slips Problems ........ A-18

© Intellectual Reserve, Inc. All rights reserved.

English approval. 6/11. 06763
Overview

Duties of Stake and Ward Clerks

The stake clerk and assistant stake clerk should become experts at using the Member and Leader Services (MLS) software and should ensure that ward and assistant ward clerks are trained to use the system. The ward clerk should consult with the stake clerk if he has questions about MLS. The stake clerk should contact Church headquarters if he needs additional information or help. The stake clerk can request help by sending an MLS message to his service center.

Overview of MLS

MLS is for use by unit leaders, clerks, auxiliary and quorum leaders, and secretaries at both the ward and stake levels. MLS allows users to:

- Record donations
- Record payments for orders from the Church Online Store (where available)
- Account for budgets, income, and expenses
- Record changes to membership records
- Move membership records from one ward to another
- Print reports, directories, action lists, and checks
- Keep track of temple recommends
- Record ordinances and print certificates
- Organize callings and classes for auxiliaries and quorums
- Create boundary realignment models for the stake
- Print and transmit the Quarterly Report
- Record tithing declarations and print and transmit the Tithing Declaration Report
- Print official year-end donation receipts

System Log In

Each member using MLS must log in to the system using his or her own user ID and password. Each user will see a different set of menus depending on his or her system access rights.

Security

1. **System administrator.** The unit leader assigns an MLS system administrator for his unit. The system administrator maintains the list of MLS users and controls the security rights for those users. When MLS is installed at the ward level, the stake administrator should also be given an out-of-unit administrator account on the ward level. This will allow someone from the stake to assist the ward users as necessary.

2. **Passwords.** User passwords should not be shared. Each user should change his or her password periodically, at least once a quarter. Passwords must be at least eight characters long and must contain at least one alphabetic character and one numeric character.

3. **Those who may use MLS.** On the stake level, the stake presidency, stake executive secretary, and stake clerk and assistant stake clerks may be given access to MLS. On the ward level, the bishopric, executive secretary, ward clerk and assistant clerks, and quorum and auxiliary leaders and their secretaries may be given access to MLS.

4. **User rights.** An MLS user should receive only those rights needed to perform his or her calling. For example, those who use MLS to enter donations (such as a unit leader, his counselors, and the finance clerk) should have “Finance” rights. As members receive new callings or are released from callings, their access rights to MLS should be changed to reflect their current callings. The rights that may be assigned to MLS users include:
   a. **Administrative.** All MLS functions are available, including the right to add or delete new users.
b. **Edit Membership.** At the ward level, gives the rights to view and change membership data. At the stake level, gives the right only to view membership data.

c. **Finance.** Gives the rights to view and change financial data and the right to view membership data.

d. **Organization.** Gives the rights to view and update organizational data, such as callings within an auxiliary or quorum.

e. **View Membership.** Gives the right to view basic membership data but not the right to update it.

f. **Edit Recommends.** At the stake level, gives the right to enter or edit temple recommend information.

g. **View Recommends.** At the stake or ward level, gives the right to view temple recommend information.

**General MLS Information**

**Urgent Tasks**

If you have overdue or unfinished tasks, a notification box pops up when you sign in to MLS. This box allows you to navigate to the area of MLS where the urgent task may be performed.

**Sorting Reports**

Most reports can be sequenced in various ways by clicking on column headers. The first time you click a column header, the data in the column is sorted alphabetically. If you click the same column header again, the information is sorted in the reverse order. You can also change column widths by placing the mouse pointer on the line between column headers, clicking and holding, and then dragging the line left or right.

**Stake Data Transfer**

Each time the ward does a Send/Receive Changes that contains membership data, the membership data is sent to the stake as well. After it arrives at the administrative office and is processed, it is sent to both the stake and ward MLS. This process will be unnoticeable to the ward. If the stake needs ward data at other times the ward may send its data by clicking the File drop-down menu and selecting Send Membership Data to Stake. This, however, sends only limited membership data.

Stakes also have the ability to request a membership update from the administrative office. However, caution should be used because the stake will receive only basic membership data. Much of the enhanced data previously sent directly from the ward will be erased.

**Unit-to-Unit Messaging**

The stake may send messages to the wards, and the wards may send messages to the stake. It is also possible to send messages between the ward or stake and Church headquarters.

**Membership Records**

**Confidential Nature of Membership Records**

Membership records are confidential. Only the following people should have access to a member’s record:

- The member (in the presence of the bishop or clerk assigned to membership records)
- Bishopric members
- Ward clerk
- Assistant ward clerks
- Parents of the member (in the presence of the bishop or clerk assigned to member records) if:
  - a. The parents have legal custody
  - b. The child is under 18
  - c. The child is living in the same household

Only the bishopric and clerks have access to all membership information in MLS. By using a password, priesthood and auxiliary leaders can access MLS information pertinent to their organizations, but they will not have access to the complete membership database.
Wards may print an Individual Ordinance Summary (IOS) for each member. This IOS contains much of the same information as the membership record. The member may keep the IOS.

Duties of the Clerk Assigned to Member Records
The clerk assigned to member records works under the bishop’s direction. The clerk’s duties are to:
1. Create new membership records for children under age eight.
2. Keep official membership records up to date.
3. Request membership records when members move into the ward.
4. Transfer membership records when members move from the ward.
5. Prepare certificates of blessing, baptism and confirmation, and Aaronic Priesthood ordinations.
6. Print general ward membership directories, action lists, and statistical reports as requested.
7. Print organization lists and rolls or help auxiliary and priesthood leaders print their own lists and rolls.
8. Provide help, as requested, to priesthood and Relief Society leaders in using MLS to support home and visiting teaching.
9. Maintain, as requested, Church calling information.
10. Generate the Quarterly Report.

Getting Help
If you have questions about MLS that are not answered by this manual, you may contact the stake technology specialist or the stake clerk. The stake clerk may contact Church headquarters.
You may also send questions about MLS over the modem or Internet using the MLS messages feature. MLS Support will respond to these messages within two working days. To create and send messages:
1. On the main MLS screen, click Messages.
2. Click Create Message at the bottom of the screen.
3. After creating the message, click Send Messages at the bottom of the screen.

Members of Record
For statistical and reporting purposes, the following persons are members of record and should have a membership record:
1. Those who have been baptized and confirmed.
2. Those under age nine who have been blessed but not baptized.
3. Those who are not accountable (see “Not Accountable” in this document).
4. Unblessed children under age eight when:
   • Two member parents request you create a record.
   • One member parent requests you create a record and the nonmember parent gives permission.
A person who is nine years of age or older who has a membership record but has not been baptized and confirmed is not considered a member of record. However, the bishop keeps the membership record until the person is 18. At that time if the person chooses not to be baptized despite being given every opportunity, the bishop, with written permission from the stake president, may cancel the membership record. He should not, however, cancel membership records of persons not considered accountable because of mental disabilities.

Receiving Membership Records
Every member of the Church has an official Church membership record maintained in a headquarters membership office. A copy of each membership record assigned to the ward is maintained in the MLS membership record file. Copies may be printed by MLS on plain letter-size paper. When you receive a membership record electronically from the administrative office:
1. Check the accuracy of the records for converts and children.
2. Give the bishop the records for converts and for members moving into the ward, as well as the records with confidential information (such as a disfellowshipment).
The bishop should file the records with confidential information in his confidential files. He can use the records of converts and members moving in for fellowshipping purposes. Printed membership records that are not needed should be destroyed in a manner that makes it impossible to reconstruct them.

**Membership Record Updates**

- **Membership Record Transaction Reports.** When membership record transactions are created and transmitted to the administrative office, a Membership Record Transaction Report will automatically print. Keep this report and compare it with Membership Record Update Reports you receive from the administrative office electronically. Verify that your transactions were processed correctly.

- **Membership Record Update Reports.** When you receive updates to the member records from the administrative office electronically, the Membership Record Update Report will print. You should compare this to the Membership Record Transaction Reports to see that the transactions were processed correctly by the administrative office.

**Out-of-Unit Member Records**

You can create an out-of-unit member record in MLS for a member whose membership record is not in the ward but who has a calling in the ward. Examples are the bishop of a student ward or a branch president who is a full-time missionary.

The actual member record should remain in the member’s home ward. When the calling is concluded, the out-of-unit member record should be removed.

**Nonmember Records**

Create a nonmember record only when the nonmember is related to a member of your ward and you have the permission of the nonmember. These records will be kept in your ward’s computer only and are not transmitted to the administrative office.

Information on nonmember records will not appear on organization lists and rolls because the organization profiles do not include nonmembers. Nonmembers will appear on family-type reports such as the directory of members, the telephone and e-mail directory, and so forth.

**Blessing a Child from Another Ward**

When a child being blessed is from another ward, you should still:

- Create the Child Blessing Record
- Print the Child Blessing Certificate (the bishop of your ward signs the certificate).

When you record the information in MLS, you should use the head of house information for the child’s parent and use the child’s home ward unit name and number. The administrative office will send the new record to the home ward. If you cannot follow this procedure, create the Child Blessing Record and mail it to the administrative office.

**Convert Records**

Converts to the Church are persons who are nine years of age or older when they are both baptized and confirmed. In addition, an eight-year-old child whose parents are not members or who was baptized at the same time as the parents is also considered a convert.

The mission office should create records for new members. You should receive the new record over the modem or through the Internet within two weeks. If you do not receive the record within two weeks, contact the mission office. If you create the convert membership record in MLS, use the information on the Baptism and Confirmation Record. Do not record a baptism without both a baptism date and a confirmation date.
Moving Membership Records

Requesting Membership Records

Membership records should be kept in the ward where a member lives. Records may be sent to young single adult wards and specific language wards if the stake is in the area covered by these wards (some specialized wards cover a large geographical area that includes several stakes). Exceptions require the consent of the bishops and stake presidents involved and approval from the First Presidency.

Moving Membership Records from the Ward

Move a membership record out of the ward when the member no longer lives in the boundaries of your ward and will be gone longer than three months.

If local leaders are unsure where a membership record should be (such as for a member in a hospital for an extended stay or for a member without a permanent address), they should keep the record in the ward that can best meet the needs of the member.

Full-Time Missionaries

The membership record of a full-time missionary should be kept in the missionary’s home ward. This is generally the ward where the parents live.

Youth Away from Home

When a youth leaves home to go to work or school, you should move the membership record to his or her new ward.

Members with Leadership Assignments

When members are called to leadership assignments in other wards and are not required to move, keep the membership records in the home ward. If a member has a leadership assignment that requires moving to a new home for more than three months and there are children involved, move the records of the family to the new ward.

Members in the Military

When a member joins the military, keep the membership record in the ward until he or she completes basic training. After the member completes basic training, move the record to the ward serving the member’s permanent duty station. Be sure to include the military post office address if known. If a member is assigned to a combat zone, the record is usually kept in the ward that supports the duty station. The location of a military group can change rapidly.

Miscellaneous Membership Policies

Certificates and Forms

You can prepare and print membership-related certificates and forms in MLS. On the MLS menu bar, click Reports/Forms. Click either Certificates or the name of the form you want.

Custom Reporting

In MLS there is a set of predefined talents and interests available to assign to members. You may also assign custom talents and interests to members to enhance custom reporting. To assign custom talents, on the MLS drop-down menu bar, click Membership. On the menu that drops down, click Custom Member Fields.
Data Export
You may export selected MLS data to use in a spreadsheet or a handheld computer application. Click the File drop-down menu and select Export. The first four selections on the list that appears are comma-separated files (.csv) that may be loaded into a spreadsheet or any application that accepts this type of file. The last two file types on the list can also be exported as .csv files or as vCard files for Palm handheld computers.

To load these files, go to the Palm Desktop application. Click the Address feature. Add categories for family data and individual data. While in the family data category, click the File—Import menu option to bring up a file selection box. Change the Files of Type field to “Comma Separated (*.csv, *.txt).” Go to the folder containing the file called “PalmFamily.csv” that you created from the MLS export. Select this file and click Import to load the data into the Palm Desktop file. When the files are loaded into the Palm Desktop application, hot sync with the handheld unit and the data will be transferred. Names are listed in the address list of the handheld in the category you selected. Tap the name to see the detail information. In some areas, MLS data exports may be restricted because of data privacy laws.

Duplicate Membership Records
If you have more than one membership record for the same member but each record has a different member record number, keep the most correct record and delete all others. Use the “Cancel Record” feature of MLS.

Full-Time Missions
Outside the United States and Canada, record full-time missions on the membership record as soon as possible after the member is set apart. Record only one full-time mission. This will usually be the member’s first mission, but members may choose which full-time mission or Church-service calling they would like recorded.

In the United States and Canada, do not record missions. The Missionary Department will add the mission to the missionary’s record after he or she has been in the mission field for two months.

Head of Household
The head of a household should be the member to whom all the other household members are tied in the records. In MLS, the head of household is usually the husband or father, whether he is a member of the Church or not. In certain cases, the head of household may also be another member parent, a single member, or a member child whose parents are not members.

Marriages
Both temple and civil marriages should be recorded on membership records. Temple marriages are recorded by the temple, and the records are updated through the administrative office. When recording a civil marriage, enter the spouse’s membership record number if possible. When a spouse’s record number is present on a membership record, the spouse’s name or maiden name will automatically be retrieved from the spouse’s record at the administrative office. Marriage dates and places are kept in both spouses’ membership records.

Name Changes
When a member has legally changed his or her name, make the change on the membership record as soon as possible. Follow this same procedure to correct spelling or typographical errors. The bishop should make sure all legal requirements have been completed.

Not Accountable
If a member with mental or physical limitations is not able to knowingly repent, the member is considered not accountable and is not baptized. Only the bishop can make this determination. Not accountable status cannot be used for members who have already been baptized and confirmed, and cannot be put on a membership record until a person is age eight or older.
Organizations

Organization positions and classes have standardized names in MLS. You can add custom organizations and positions to the standard organizations. On the MLS drop-down menu bar, click Organizations. On the menu that drops down, click the name of the organization wanted. The Add Position links are available to add both standard positions and custom positions.

Prior Marriage Information

Only the official record at the administrative office contains prior marriage information for members. The record stored in MLS does not. It has information only about a current or deceased spouse. It will, however, indicate if a member is sealed to a prior spouse.

If you are creating a record for a convert, include prior spouse information. This is, however, usually done by the mission office.

Sensitive Information

Certain information in MLS and on membership records is considered sensitive, such as birth year of adults; temple recommend status; and sealing, endowment, and disciplinary information. Under the direction of the bishop, quorum and auxiliary leaders should receive only the information they need to fulfill their callings.

Software Changes

In MLS, software changes are made automatically when you send and receive changes. You will receive a message that the software change has been made and that you should restart your computer. You may also receive a message explaining the changes.

Temple Ordinance Updates

Temple ordinance information for living members is sent from the temple directly to the administrative office to update the membership record. The ward should receive and updated record within two weeks after the temple ordinance.

If an updated membership record with the temple ordinance data has not been received within two weeks, you can submit the change. However, the administrative office will match the information with the temple’s information before making the change.

Finances

Budget Allowance

The budget allowance is an amount of money the administrative office gives to a stake. (In the United States and Canada, the administrative office is Church headquarters.) The amount given to the stake is based on sacrament meeting attendance reported on the Quarterly Report by the wards in the stake. Additional amounts are given based on the number of Primary children, young women, young men, and young single adults in the stake. The stake president distributes percentages of this money to each ward based on need. This money comes from tithing funds and is used by stakes and wards to pay for programs and activities.

The following principles govern the budget allowance:
1. The budget allowance program was created to reduce financial and time burdens on members.
2. Members should not pay or be assessed fees to participate in Church activities.
3. If necessary, priesthood and auxiliary leaders should reduce and simplify activities to stay within the budget allowance.
4. Expenditures must be approved by the stake presidency or bishopric.
**Tithing and Donations**

Tithing and other donations are normally received by members of the bishopric. A donor completes a Tithing and Other Offerings slip, places the slip and money in a tithing envelope, and gives it to a member of the bishopric. It may also be mailed to the bishop. Each week the clerk assigned to finances and a member of the bishopric (or two members of the bishopric) account for the donations. A member of the bishopric and another Melchizedek Priesthood holder put the money in the bank. Some countries, however, have additional acceptable methods to receive donations.

**Fast-Offering Donations**

Fast offerings are sometimes collected by members of the Aaronic Priesthood going door-to-door in pairs and handing out fast-offering envelopes. Each envelope contains a Tithing and Other Offerings slip. A donor may record the amount of his or her fast offering and place the slip and money in the fast-offering envelope while the members of the Aaronic Priesthood wait. The members of the Aaronic Priesthood then give these envelopes to a member of the bishopric, who includes them with other donations when recording donations on Sunday. Only fast offerings may be gathered in this manner.

**Using the “Other” Category**

The “Other” category of your checking account is used for pass-through funds, which are funds generally raised or collected to pay for goods or services not covered by budget funds. In areas where members and others can pay for Church Online Store orders through the ward or branch, use the Other Category and Online Store Purchases subcategory to process the order.

Examples of pass-through funds may include Church magazines or Young Women camp. These funds are deposited and then disbursed by check. Most pass through quickly, although some may accumulate if they are earmarked for a future activity. Funds collected and not used should be returned to the donors. If funds in the “Other” category drop to a negative balance, use budget funds to bring the balance back to zero. Do not use budget funds for Pay through Ward or Branch Online Store orders.

**Paying for Online Store Purchases through the ward or branch (Where Available)**

Where available, members and others who do not have a bank card or checking account can order items from the Church Online Store and pay for them through their local ward or branch using cash and coins.

To pay for Online Store purchases through the ward or branch the person placing the order will:

1. Go to store.lds.org.
2. Select the appropriate country.
   - The country selection is near the lower right-hand corner of the window, next to the language name. They might have to scroll down to see it.
3. Sign in using their LDS Account.
4. Add the desired materials to their cart.
5. Click Checkout.
6. Under Select Payment Type, choose Pay through Ward or Branch.
7. Print the Quote Receipt.
8. Put their cash and the printed Quote Receipt in an envelope, seal the envelope, and give it to a member of your bishopric or branch presidency. The envelope should not be a Tithing and Other Offerings envelope.

Bishopric members and clerks account for and process online store purchase funds by entering the Quote Receipt number and amount in MLS using the Other Category-Online Store Purchases subcategory. To prevent confusion, process all Online Store orders together, and all tithing and other offerings together. Tithing and other offerings and Online Store purchases can be included in the same batch.
If an envelope (not a Tithing and Other Offerings envelope) has the person's name on it and money inside but without a Quote Receipt, the clerk or bishopric member should attempt to contact the person immediately to find out what the funds are for. If the funds are for an Online Store order, the person should provide the Quote Receipt. If the person cannot be contacted immediately, the ward clerk, accompanied by a member of the bishopric, should return the money to the person. No money should be left with a ward clerk, a member of the bishopric, or in a Church building.

If an envelope has funds in it and there is neither a Tithing and Other Offerings slip nor a Quote Receipt in it and the bishopric member can identify which person who gave him the envelope, clerk or bishopric member should immediately contact the person and ask what the funds are for. If the person who gave the bishopric member the envelope cannot be identified, complete a Tithing and Other Offering slip and process the money as a tithing donation in the name of an anonymous donor.

If the amount of money in the envelope is less than the Quote Receipt, the clerk or bishopric member should contact the person immediately to get the correct funds. If member cannot be contacted, the clerk and a bishopric member should return the money to the person. If the amount of money in the envelope is more than the Quote Receipt, the clerk and a bishopric member should return the money to the person.

Do not refund any money for Online Store orders. The person requesting the refund should contact the Global Services Center to request the refund.

The Quote Receipt number and the amount for the order will appear on the unit financial reports.

**Recording Tithing and Donations (and online store purchase payments, where available)**

After tithing and other donations are received each Sunday, a member of the bishopric and the clerk assigned to finances (or two members of the bishopric) record and account for these donations and Online Store order payments. They do the following:

1. Open all collected tithing envelopes, fast-offering envelopes, and online store purchase payment envelopes.
2. If there are errors or discrepancies between the amount of money in the envelope and the amount recorded on the slip, contact the donor as soon as possible to resolve it.
3. Enter amounts from the slips in MLS.
4. Stack the slips in one pile. Separate currency, coins, and checks into three separate piles.

**Making the Bank Deposit**

1. After the clerk and a member of the bishopric (or two members of the bishopric) authorize the donation information, MLS prompts them to print the Deposit Report. There are two parts to this report: the bank copy and the ward copy. The two people who counted and verified the donations should initial the ward copy of the Deposit Report where indicated.
2. After printing this report, two persons prepare the bank deposit. This will include the checks, the currency, the coins, and the bank copy of the Deposit Report. The amounts of the checks, currency, and coins should match the amounts listed on the Deposit Report.
3. The clerk and a member of the bishopric (or two members of the bishopric) prepare a deposit slip and keep a copy of the deposit slip for the ward files.  
   **Note:** Do not print each check amount on the deposit slip (unless required by the bank); print only the total of all checks, total currency, and total coins. The amount of each check is included on the bank copy of the Deposit Report.
4. The two members preparing the deposit put the deposit slip, the funds, and the bank copy of the Deposit Report in the bank bag. A member of the bishopric and another Melchizedek Priesthood holder make the deposit on the same day where possible. If not possible, follow deposit instructions from the area controller.

**Banking Policies**

**Handling Returned Checks**

A returned check is a donor’s check that was deposited, but for which the bank refused payment because of insufficient funds, a closed account, or some other reason. The following happens with returned checks:

1. Church headquarters adjusts the donor’s record for the amount of the check and the categories he or she contributed to.
2. The next time the donor’s local unit uses Send/Receive Changes, the adjustments are entered into MLS automatically.
3. Church headquarters generates a letter to the donor that explains the returned check and which amounts were adjusted in his or her records. The returned check is attached to the letter and sent to the donor. The local unit and local unit clerk take no action in regards to a returned check.

**Stopping Payment on a Check**

Stop payment on any check that is lost, stolen, or canceled and no longer in your possession. Do this immediately when a check is lost or stolen. Contact your financial institution (in the United States and Canada, contact Church headquarters). Give the following information as appropriate:

- Name of your unit
- Checking account number
- Date of the check
- Name of the payee on the check
- Exact amount of the check
- Check number
- Reason for stop payment
- Replacement check number
- Your name and daytime telephone number

If the check was recorded in MLS, adjust the check amount to zero. To do this, on the MLS drop-down menu bar, click **Finance**. Click **View/Update Expenses**. In the reference number column, click the check number. When the Expense screen comes up with the details of the check, click **Void**. Click **Continue** and enter the reason for the adjustment, such as “Lost Check” or “Stolen Check.” Click **OK**.

**Voiding a Check**

If a check has been printed but not given to the payee, there is no need to request a stop payment if there is a problem with the check. If the check is no longer needed for the purpose for which it was printed, void the check in MLS as follows:

1. Tear out and destroy the signature lines on the check.
2. By hand, print “VOID” on the check and any copies.
3. File the voided check in numerical order with the other expense documents.
4. Void the check in MLS. To do this, on the MLS drop-down menu bar, click **Finance**. Click **View/Update Expenses**. In the reference number column, click the check number. When the Expense screen comes up with the details of the check, click **Void**. Click **Continue** and enter the reason for the adjustment as “Check Never Issued.” Click **OK**.
Tithing Settlement

Tithing settlement is an opportunity for each ward member to meet with the bishop to make sure his or her donation records are correct and to declare to the bishop his or her tithing status. It gives the bishop an opportunity to discuss with families the principle of tithing, encourage a generous fast offering, and discuss other financial and spiritual matters.

There is a tithing settlement lesson for many languages on LDS.org. From the home page, follow this path: Menu > Service > Serving in the Church > Melchizedek Priesthood > Leader Resources > Record-Keeping and Auditing Training. From this page, first choose your language. Then look for the lesson titled “Tithing Settlement.” This lesson will take you through the steps of tithing settlement.

If the tithing settlement lesson is not available in your language, you should receive instructions from your administrative office.

Tithing Status Definitions

1. **Full-Tithe Payer.** All donors whose tithing is “‘one-tenth of all their interest annually,’ which is understood to mean income” (First Presidency Letter, Mar. 19, 1970; see also D&C 119.4).
   - Tithing status is normally the same for husband and wife who donate together. It may be different if they donate separately.
   - Converts baptized during the year who have paid a full tithe since baptism are full-tithe payers.
   - Full-time missionaries serving from your ward are full-tithe payers. (However, missionaries should pay tithing on personal income beyond the amounts they receive for their support.)
   - Members entirely dependent upon Church welfare assistance are full-tithe payers.
   - Some members may have paid tithing to Church headquarters or in a previous ward. These donors should declare tithing status in the ward where they live at the time of tithing settlement.

2. **Part-Tithe Payer.** All donors who have paid tithing but the amount is less than a full tithe.

3. **Exempt-Tithe Payer.** All donors who have no income and have not contributed to tithing funds but declare they would have paid a full tithe if they had income. Full-time missionaries are not exempt-tithe payers. They are full-tithe payers. A married donor with no income should be reported the same as the spouse unless the member declares otherwise. Only the member can make the declaration of Exempt. The bishop cannot make this declaration for the member.

4. **Non-Tithe Payer.** Ward members who have not contributed tithing during the year and are not exempt from paying tithing.

Special Cases

1. **Those in the ward who contributed but did not attend tithing settlement.** The bishop should complete a Tithing Settlement Statement for each donor who contributed but did not attend tithing settlement. The bishop should declare the tithing status and make sure the status is entered in MLS. Deliver or mail statements to those you have addresses for. Keep the rest for a year in case the donors ask for them.

2. **Those in the ward who did not contribute.** The bishop should declare a tithing status for every member of the ward whether they contributed tithing and donations or not, including all children. He should make sure the status of each member is entered in MLS.

3. **Members who died.** Print statements but do not record a tithing status unless the member died after tithing settlement. If the member’s name appears on the Tithing Declaration Report, enter “Deceased” in the Notes column on the Tithing Declaration Report. Deliver or mail the statement to the donor’s spouse or family.

4. **Members from your ward serving full-time missions.** Mark the tithing status as “Full-tithe” on the Tithing Settlement Statement. Print “On mission” in the Notes column on the Tithing Declaration Report. Give the statement to the missionary’s parents or mail the statement to the missionary.

5. **Donors who contribute in kind or directly to Church headquarters.** There will be no amounts on the Tithing Settlement Statement for these donors. Print “Donated in kind” or “Donated to headquarters” in the
Notes column on the Tithing Declaration Report. The bishop should also record the member’s tithing status declaration.

6. **Donors who are not members of the ward.** Do not complete the tithing status. Deliver or mail statements to those you have addresses for. Keep the rest for one year in case donors ask for them.

7. **Young single adults.** If young single adults have their membership records in young single adult wards, encourage them to attend tithing settlement in the young single adult wards. Tithing status must be declared by the bishop of the ward where their membership records are.

8. **Donors with two residences.** Those who spend part of the year at one residence and part of the year at another should attend tithing settlement in the ward where their membership record is located during tithing settlement.

9. **Statements for organizations.** Print statements but do not complete the tithing status. Deliver or mail statements to those you have addresses for. Keep the rest for one year in case organizations ask for them.

**Ward Division or Boundary Change**

If there has been a ward division or boundary change that affects tithing settlement, do the following.

At the time of the ward division or boundary change, the clerk of the former ward should:

1. Print Tithing Settlement Statements for members whose membership records were transferred out of the ward.
2. Give the Tithing Settlement Statements to the bishop or clerk of the new ward.

The clerk of the new ward should:

1. Deliver or mail statements received from the former ward to donors. Do not record on these statements tithing and offerings submitted in the new ward.
2. Print statements on the new ward’s computer for tithing and offerings received since the donor has been attending the new ward.

The bishop of the new ward conducts tithing settlement for donors assigned to the new ward.

**Discontinued Wards**

At the time a ward is discontinued, the stake should receive for each member the Tithing and Other Offerings Statement and official tax-valid statement from the bishop or clerk of the ward being discontinued. The stake president should distribute these statements to the bishops in the wards where the members are assigned to attend.

The clerk should transmit the Tithing Declaration Report to the administrative office no matter what time of the year the ward is discontinued. Donors should attend tithing settlement in the ward where they live when tithing settlement is held.

**Stake Procedures**

The stake president should receive the Tithing Declaration Report from each ward by January 31. The stake president (or stake clerk, if assigned) reviews each report by doing the following:

1. Make sure that:
   - The ward recorded tithing status for each member on the report or made a note explaining why they did not (such as “Moved”).
   - Tithing status is marked for those who are living in the ward at the end of the year. Tithing status should not be marked for those who have moved out of the ward.
   - Full-time missionaries with membership records in the ward are recorded as full-tithe payers.
   - Ward members who paid tithing in kind or paid directly to Church headquarters have their status recorded.
2. If a ward’s information does not seem reasonable or correct, follow up with the ward clerk. If changes are made in the ward computer, have the ward clerk print a new Tithing Declaration Report for the stake president and a corrected official tax statement for each donor affected.
3. When the report is correct, file the printed report in the stake president’s confidential file. Keep the report for as many years as are required by local laws for financial records.

**Miscellaneous Financial Policies**

**Checks**

1. **Two authorized signers.** Two authorized signers sign each check. One must be a member of the bishopric (for ward clerks) or stake presidency (for stake clerks).
2. **Filed by month.** File the stub portion of the check in numerical order by month, and keep it for the number of years prescribed by the area office. This will normally be no less than three years.
3. **Blank checks.** Never sign a blank check.
4. **Tax amounts on the check.** In some countries or states or provinces of a country, the Church must pay local taxes. You must enter the amount of the tax on your expenses screen in MLS under the Category and Amount fields.
5. **Improper disbursements.** Stakes and wards should not print the following kinds of checks:
   - Checks from fast-offering funds that are signed by the person receiving the assistance. The bishop should not authorize fast-offering assistance to himself without consulting the stake president.
   - Checks used to pay off a member’s consumer debt.
   - Checks to missionaries who are on the equalized payment program. The only checks that may be written from the ward missionary fund are to help support older couples or Church-service missionaries called from the ward, when their personal funds are insufficient to cover the cost of their missions. The stake president may also direct the ward to write a check from the ward missionary fund to the stake or to another ward in the stake.
   - Checks from specially collected funds that are not authorized, such as “Other” funds collected to help a needy family (help for the needy is a fast-offering expense and should not be collected separately).
   - Checks to return donations to the donor. Stake and ward leaders are not authorized to return donations to donors.

**Computer Failure**

If the computer or other electronic equipment used to run MLS fails and cannot be restored within four weeks, and no temporary computer is available, do the following:

1. If replacement equipment or repairs are necessary, contact the stake technology specialist. He will work with the administrative office to get the computer operational as quickly as possible.
2. Until the computer is operational again, account for tithing and other offerings using an adding machine tape. Do the following:
   a. With a member of the bishopric or stake presidency, open each donation envelope and make sure that on the Tithing and Other Offerings slip the category amounts added together equal the total amount and that the actual money is the same amount as the total reported on the slip.
   b. Put all the money in one stack and all the Tithing and Other Offerings slips in another stack.
   c. Use the adding machine to balance the amounts on the slips. You should have the following totals:
      - Tithing and Other Offerings slips total*
      - Tithing amount total
      - Fast offering amount total
      - Ward missionary amount total
      - General missionary amount total
      - Book of Mormon amount total
      - Humanitarian aid amount total
      - Temple construction amount total
      - Perpetual education amount total
• Other (specify) amount total
• All category totals added together*
  *The totals from the two underlined items should be the same.

3. Count the money and complete a deposit slip. The total amount of the money should be the same as the two underlined items above.
4. Deposit the money in the bank the same day you prepare the deposit slip. Use a night depository when depositing on Sunday.
5. File the adding machine tape, a copy of the deposit slip, and the Tithing and Other Offerings slips together in a weekly file.
6. Telephone the administrative office for instructions on writing and recording checks.
7. When the computer is working again, do the following:
   a. Restore the data to the computer from a removable storage medium such as a flash drive. To do this, under the File drop-down menu, click **Restore from a File**.
   b. For batches missing from the restored data, type each week’s Tithing and Other Offerings slips amounts in the computer as a separate batch. There should be a separate batch for each individual deposit made while the computer was inoperative.
   c. Put the ward copy of the Deposit Report and the Tithing and Offerings Batch Report in the same file with the adding machine tape that was used to keep track of the deposit while the computer was inoperative.

**Discontinued Ward**

If the ward is discontinued, do the following:
1. Print the Tithing and Other Offerings Statements for each donor and give them to the stake president.
2. Print the official tax statements for each donor and give them to the stake president.
3. Transmit the Tithing Declaration Report to the administrative office no matter what time of the year the ward is discontinued.
4. Destroy the unused check stock.
5. Turn in financial records to the stake clerk. This includes any backups on removable storage media. The stake should keep the records for the time required for financial records by local laws.

**Missionary Financial Support for Wards on the Equalized Payment Program**

*General guidelines:*

Wards with full-time single proselyting missionaries on the equalized missionary payment program pay the same amount each month for each missionary no matter where the missionary serves. The general procedure is given below:

1. The ward provides an equal amount each month for each missionary called from the ward. To have the necessary funds available, bishops accept donations from missionaries, their families and friends, and from all ward members. If necessary, the stake president or bishop may ask stake or ward members to help support these missionaries by contributing to the ward missionary fund. However, Church leaders are not to solicit funds for any purpose, including the support of missionaries, outside the boundaries of their own Church units.
2. Each month, the ward pays the administrative office the monthly amount for each missionary. In some countries, the administrative office automatically charges the ward checking account the monthly amount for each missionary.
3. Church headquarters distributes the money to missions as need. The mission gives the missionary a monthly amount based on living costs in the mission area. This may be less or more than the monthly amount deposited in the ward account.
4. This monthly procedure occurs 18 times for sister missionaries and 24 times for elders.
**Note:** Full-time missionary couples (regardless of assignment), full-time single missionaries who are not serving proselyting missions, and those on Church-service missionary assignments are not affected by this equalized funding procedure. These missionaries, to the extent that they are able, should pay their necessary expenses directly from their own personal resources and should not contribute the amounts for those expenses to the Church as missionary contributions.

To the extent that missionaries are unable to provide directly all of their own support, they may be assisted from the ward missionary fund if funds are available. The bishop may encourage and accept contributions from any other source within the ward to the ward missionary fund to maintain a reasonable reserve for this purpose.

Ward missionary funds should not be used to send additional money to missionaries who are covered by the equalized funding procedure or to fund any other ward or stake missionary activities. As with all contributions to the Church, donations for missionary service belong to the Lord and may not be refunded to contributors.

**Monthly amount:**

The monthly amount represents the average cost of supporting missionaries worldwide as approved by the First Presidency and is subject to change depending on general economic conditions. If the monthly amount changes, stake presidents and bishops will be informed by a letter from Church headquarters.

**Charges to the ward checking account:**

For those wards that have their monthly amounts automatically taken out of their accounts by the administrative office, each missionary’s subcategory in the Ward Missionary account will be charged the equalized monthly payment amount. This charge will begin in the month the missionary enters the MTC. The bishop will receive information about the monthly amount when he receives notification of the missionary’s call.

Each missionary’s Ward Missionary subcategory will be charged the first Thursday of every month. Bishops should make sure there are enough funds in the account by that time.

**Donations:**

Donations should be in the ward account by the end of the month previous to the month the missionary enters the MTC. For example, if the missionary enters the MTC in March, donations should be in the ward account by the end of February.

**Change in the missionary’s home ward:**

When a missionary’s home ward changes (such as when his or her parents move), wards should use the following guidelines:

1. The bishop of the missionary’s previous ward should notify the bishop of the new ward that his ward is now the missionary’s home ward. The bishop of the former ward cannot transfer financial responsibility for the missionary’s support to the new ward unless the bishop of the new ward agrees and willingly accepts the responsibility for the support. Then either bishop may notify the administrative office of the change.
2. When the primary support is being supplied by the parents of the missionary, they should contribute support funds to the new ward. If the new ward does not agree to accept responsibility, responsibility continues with the old ward.

**Extensions:**

If a missionary receives an extension of 15 days or more past the 24-month time period for elders or the 18-month time period for sisters, an additional payment will be charged to the ward account for each month thereafter.

**Other missionary finance guidelines:**

1. Contributions to the ward missionary fund that have not been used when a missionary is released should be kept in the ward missionary fund and used as needed. Never refund missionary contributions to a donor.
2. The bishop, with the stake presidency, should determine when ward missionary funds exceed reasonable ward or stake needs. Any excess should be sent to the administrative office by check or by letter indicating the amount of excess by unit.

3. If there is a need to redistribute missionary funds within the stake, it may be done one of three ways depending on the area:
   - Wards having excess missionary funds print a check and give it to the stake. The stake then prints checks for wards needing additional missionary funds.
   - The stake sends a letter to the administrative office with the amount to redistribute and to whom.
   - Stakes enter a transfer in MLS.

**Outstanding Checks**
Checks printed by the stake or ward that have not been cashed in a reasonable amount of time are called *outstanding checks*. For checks that have been outstanding for six months or more, do the following:
1. Contact the payee to see why the check has not been cashed. If the payee wants to (1) cash the check or (2) donate the check back to the Church, print a replacement check for the payee. Void the original check in MLS.
2. If the payee says the check is a duplicate payment made in error, void the check.
3. If you cannot locate the payee, void the check in MLS. (Units in the United States should see the step below.)
4. If your stake or ward is in the United States, you are subject to unclaimed property laws if you cannot find the payee. Do not void the check. Church headquarters will provide additional instructions by letter.

**Property Tax Exemption**
In many countries the Church may obtain exemption from property taxes on most ecclesiastical properties used for exempt purposes. The Church Tax Administration handles all property tax filings and payment for Church properties. Therefore, all property tax correspondence, including bills, valuation notices, and so forth should be forwarded immediately to the Church Tax Administration Division.
Wards should not do anything to endanger the Church’s tax-exempt status. Such actions could have repercussions far beyond the stake borders. Wards must not:
1. Rent out meetinghouses or parking lots.
2. Rent out meetinghouses for events such as wedding receptions and reunions. Members may use meetinghouses at no cost for these kinds of events.
3. Use Church property for the sale of commercial items or for any commercial purpose.
4. Conduct unauthorized fund-raising activities on Church property.
5. Advertise social events to the general public and charge admission.
6. Have a mandatory charge to any social activity.

**Records Management**
1. Protect all information against unauthorized access, change, destruction, or disclosure. Highly sensitive records, including computer printouts and removable storage media, (1) should never be left unattended when they are being used and (2) should be kept in a locked drawer or cabinet in the bishop’s or stake president’s office when not in use.
2. Keep records for the length of time required by national and local laws for financial records. The area office can tell you what this length of time is.
3. Do not discard or destroy records that may have historical value. Contact the Church History Department about such records, and they will decide the disposition of them. Destroy other records that are no longer needed in such a way that they cannot be reconstructed.
Reimbursements

Normally the stake president, bishop, and stake and ward leaders using stake or ward funds should (1) determine the amount needed, (2) make sure the expense is approved by the stake president or bishop, and (3) have the clerk prepare the check and get the proper signatures.

A receipt should be given to the clerk as proof of purchase.

When members seek reimbursement for items purchased with their own funds, they should give the clerk or a member of the stake presidency or bishopric a receipt or invoice showing the amount and date of the purchase. If a receipt or invoice is not available, the member should make a full written explanation of the expense, including the date. The bishop or stake president should approve any reimbursement. The clerk can then prepare a reimbursement check and get the proper signatures.

Stake Income

The stake president gives income for the stake to a member of the stake presidency; he in turn works with the clerk to make sure all funds are accounted for.

Stakes normally accept (1) surplus funds from the wards, (2) funds for the “Other” category to pay for expenses for authorized activities and fees, (3) funds for authorized family history centers, or (4) returned unspent budget funds. Member donations should be made at the ward level.

During the week, the stake presidency receives money from various sources. All income should be recorded on a Tithing and Other Offerings slip. Some income will already have a slip with it. For income that has no slip, the clerk should fill out a slip and give the “copy for the member” to the person or organization giving the income.

Tithing and Offering Amounts Are Confidential

Stake and ward financial information is confidential. Only the stake or ward clerk, assistant clerks, and the stake president or bishop and his counselors should know the amount of tithing and offerings paid by a donor or other organization. Under no circumstances should this information be given to unauthorized persons.

Tithing and Other Offerings Slips Problems

1. **No Tithing and Other Offerings slip in the envelope.** Prepare a Tithing and Other Offerings slip for the amount of money in the envelope, and print the word “Unknown” in the name block on the slip. Enter the entire amount in “Tithing” on the slip and in MLS.

2. **The Tithing and Other Offerings slip has amounts but no name.** Print the word “Unknown” in the name block of the slip and deposit the amounts to the correct categories.

3. **The amount in the envelope is more than the amount on the Tithing and Other Offerings slip.** Contact the member immediately for clarification. If the person cannot be contacted immediately, a member of the bishopric and the clerk should return the money to the person as soon as possible.
Appendix B
Member and Leader Services (MLS) Menu Structure
How to Find What You Want to Do in MLS

The Member and Leader Services (MLS) software uses two different menu structures to help you navigate:
- The MLS main menu bar
- The MLS on-screen links

The main menu bar

The main menu bar is located at the top of the screen in MLS. These menus are “drop-down” menus, meaning that when you click on one of the menu names, the selections in that menu drop down under the menu name. You can then move your mouse arrow and select the one you want. The example below is for the Telephone Directory.

The MLS on-screen links

The MLS on-screen links take you from one menu to another or from a menu to a screen. The links are blue underlined text. Some panels that contain links may also contain the word More as a link. Clicking More will take you to another screen of MLS links.

How the menu structure works

There are three columns. The left column contains a list of tasks you may want to look up. The middle column contains the method for accessing the task by using the MLS menu bar. The right column contains the method for accessing the task by using the MLS on-screen links.

Look at the example below to see how this works. The task you are looking for is “Enter Expenses.” The middle column tells you that in the MLS main menu bar, you need to click Finance. In the drop-down menu that appears, click Enter Expenses. The middle column also gives you a keyboard shortcut (Ctrl+E) to access the screen for entering expenses. The right column tells you that to use the MLS on-screen links, on the Finances panel you need to click Enter Expenses. However, you will be able to access tasks in MLS only if you have been given the rights. If you cannot access a task and think you should be able to, talk to your MLS administrator.

<table>
<thead>
<tr>
<th>To go to:</th>
<th>Using the MLS menu bar</th>
<th>Using the MLS on-screen links</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Expenses</td>
<td>Finance &gt; Enter Expenses, or press Ctrl+E</td>
<td>Finances &gt; Enter Expenses, or press Ctrl+E</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td><strong>A</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abbreviated Directory</td>
<td>Lists &gt; Abbreviated Directory</td>
<td>Reports/Forms &gt; Abbreviated Directory</td>
</tr>
<tr>
<td>Action and Interview List</td>
<td>Lists &gt; Other Lists &gt; Action and Interview List</td>
<td>Reports/Forms &gt; Action and Interview List</td>
</tr>
<tr>
<td>Add or Update Budget Categories</td>
<td>Finance &gt; Budget &gt; Add/Update Categories</td>
<td>Finances &gt; More &gt; Budget &gt; Add/Update Categories</td>
</tr>
<tr>
<td>Add or Update Donors</td>
<td>Finance &gt; Add/Update Donors</td>
<td>Finances &gt; Donations &gt; Add/Update Donors</td>
</tr>
<tr>
<td>Add or Update Fast-Offering Recipients</td>
<td>Finance &gt; Fast Offerings &gt; Add/Update Recipients</td>
<td>Finances &gt; Fast Offering &gt; Add/Update Recipients</td>
</tr>
<tr>
<td>Add or Update Payees</td>
<td>Finance &gt; Add/Update Payees</td>
<td>Finances &gt; Expenses &gt; Add/Update Payees</td>
</tr>
<tr>
<td>Adult Members Not Endowed</td>
<td>Membership &gt; Temple Recommends &gt; Adult Members Not Endowed</td>
<td>Membership Records &gt; More &gt; Temple Recommends &gt; More &gt; Adult Members Not Endowed</td>
</tr>
<tr>
<td>Application to the First Presidency</td>
<td>Other Resources &gt; Confidential Forms &gt; Application to the First Presidency</td>
<td>Other Resources &gt; Confidential Forms &gt; Application to the First Presidency</td>
</tr>
<tr>
<td><strong>B</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Backup to a File</td>
<td>File &gt; Backup to a File</td>
<td>Membership Records &gt; Record Ordinances &gt; Baptism [Select from list]</td>
</tr>
<tr>
<td>Baptism</td>
<td>— — —</td>
<td>Membership Records &gt; Record Ordinances &gt; Baptism [Select from list]</td>
</tr>
<tr>
<td>Baptism and Confirmation Record Form (Print)</td>
<td>Lists &gt; Forms/Certificates &gt; Print Form [Select from List: Baptism and Confirmation Record]</td>
<td>Reports/Forms &gt; More &gt; Forms/Certificates &gt; Print Form [Select from list: Baptism and Confirmation Record]</td>
</tr>
<tr>
<td>Baptism—Child with Record Baptism</td>
<td>— — —</td>
<td>Membership Records &gt; Record Ordinances &gt; Baptism &gt; Child with Record Baptism</td>
</tr>
<tr>
<td>Baptism—Child without Record Baptism</td>
<td>— — —</td>
<td>Membership Records &gt; Record Ordinances &gt; Baptism &gt; Child without Record Baptism</td>
</tr>
<tr>
<td>Baptism Record (Consent Version)</td>
<td>Other Resources &gt; Confidential Forms &gt; Baptism Record (Consent Version)</td>
<td>Other Resources &gt; Confidential Forms &gt; Baptism Record (Consent Version)</td>
</tr>
<tr>
<td>Baptism Record for Readmission</td>
<td>Other Resources &gt; Confidential Forms &gt; Baptism Record for Readmission</td>
<td>Other Resources &gt; Confidential Forms &gt; Baptism Record for Readmission</td>
</tr>
<tr>
<td>Beehives</td>
<td>Organizations &gt; Young Women &gt; Beehives</td>
<td>Organizations &gt; More &gt; Young Women &gt; Beehives</td>
</tr>
<tr>
<td>Birthday List</td>
<td>Lists &gt; Other Lists &gt; Birthday List</td>
<td>Reports/Forms &gt; More &gt; Lists &gt; Birthday List</td>
</tr>
<tr>
<td>Bishopric</td>
<td>Organizations &gt; Bishopric</td>
<td>Organizations &gt; More &gt; Bishopric/Other Callings &gt; Bishopric</td>
</tr>
<tr>
<td>Bishopric Action and Interview List</td>
<td>Lists &gt; Other Lists &gt; Action and Interview List</td>
<td>Reports/Forms &gt; Action and Interview List</td>
</tr>
<tr>
<td>Blessing—Record Child Blessing</td>
<td>Membership &gt; Ordinances &gt; Record Child Blessing</td>
<td>Membership Records &gt; Record Ordinances &gt; Child Blessing &gt; Record Child Blessing</td>
</tr>
<tr>
<td>Boundary Realignment (Moves)</td>
<td>Membership &gt; Boundary Realignment</td>
<td>Membership Records &gt; More &gt; Moves &gt; Boundary Realignment</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Boy Scouts</td>
<td>Organizations &gt; Boy Scouts</td>
<td>Organizations &gt; More &gt; Bishopric/Other Callings &gt; Boy Scouts</td>
</tr>
<tr>
<td>Budget</td>
<td>Finance &gt; Budget [Select View/Edit Budget, Budget Report, or Add/Update Categories]</td>
<td>Finances &gt; More &gt; Budget [Select View/Edit Budget, Budget Report, or Add/Update Categories]</td>
</tr>
<tr>
<td>Budget—Add or Update Categories</td>
<td>Finance &gt; Budget &gt; Add/Update Categories</td>
<td>Finances &gt; More &gt; Budget &gt; Add/Update Categories</td>
</tr>
<tr>
<td>Budget—View or Edit Budget</td>
<td>Finance &gt; Budget &gt; View/Edit Budget</td>
<td>Finances &gt; More &gt; Budget &gt; View/Edit Budget</td>
</tr>
</tbody>
</table>

<p>| Callings by Organization      | Organizations &gt; Reports &gt; Calling by Organization           | Organizations &gt; More &gt; Reports &gt; Callings by Organization        |
| Callings—Members with Callings | Organizations &gt; Reports &gt; Members with Callings             | Organizations &gt; More &gt; Reports &gt; Members with Callings           |
| Callings—Members without Callings | Organizations &gt; Reports &gt; Members without Callings         | Organizations &gt; More &gt; Reports &gt; Members without Callings      |
| Callings—Other Callings       | Organizations &gt; Other Callings                             | Organizations &gt; More &gt; Bishopric/Other Callings &gt; Other Callings |
| Cancel Record                 | Membership &gt; Records &gt; Cancel Record                       | Membership Records &gt; More &gt; View and Update &gt; More &gt; Other Record Changes &gt; Cancel Record |
| Change Password               | Edit &gt; Change Password                                    | Unit Name &gt; Change Password                                     |
| Check for Updates             | Help &gt; Check for Updates                                   | — — —                                                           |
| Child Blessing                | Membership &gt; Ordinances &gt; Record Child Blessing            | Membership Records &gt; Record Ordinances &gt; Child Blessing         |
| Child with Record Baptism     | — — —                                                      | Membership Records &gt; Record Ordinances &gt; Baptism with Record Baptism |
| Child without Record Baptism  | — — —                                                      | Membership Records &gt; Record Ordinances &gt; Baptism without Record Baptism |
| Church Educational System     | Other Resources &gt; Church Educational System [Select from lists] | Other Resources &gt; Church Educational System [Select from lists] |
| Confidential Forms            | Other Resources &gt; Confidential Forms [Select from list of forms] | Other Resources &gt; Confidential Forms [Select from list of forms] |</p>
<table>
<thead>
<tr>
<th>To go to:</th>
<th>Using the MLS menu bar</th>
<th>Using the MLS on-screen links</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert Baptism</td>
<td>Membership &gt; Ordinances &gt; Convert Baptism</td>
<td>Membership Records &gt; Record Ordinances &gt; Baptism &gt; Convert Baptism</td>
</tr>
<tr>
<td>Copy to Clipboard</td>
<td>Edit &gt; Copy to Clipboard</td>
<td>— — —</td>
</tr>
<tr>
<td>Copy to File</td>
<td>Edit &gt; Copy to File</td>
<td>— — —</td>
</tr>
<tr>
<td>Create Out of Unit Member</td>
<td>Membership &gt; Records &gt; Out of Unit Member Record</td>
<td>Membership Records &gt; More &gt; Create Records &gt; Out of Unit Member Record</td>
</tr>
<tr>
<td>Current Recommend Holders</td>
<td>Membership &gt; Temple Recommends &gt; View Recommends</td>
<td>Membership Records &gt; More &gt; Temple Recommends &gt; View Recommends</td>
</tr>
<tr>
<td>Custom Member Fields</td>
<td>Membership &gt; Custom Member Fields</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; View and Update &gt; Custom Member Fields</td>
</tr>
<tr>
<td>Custom Reports</td>
<td>Membership &gt; Custom Reports</td>
<td>Reports/Forms &gt; More &gt; Reports &gt; Custom Reports</td>
</tr>
<tr>
<td>Deacons</td>
<td>Organizations &gt; Young Men &gt; Deacons</td>
<td>Organizations &gt; More &gt; Young Men &gt; Deacons</td>
</tr>
<tr>
<td>Death of a Member</td>
<td>Membership &gt; Records &gt; Death of a Member</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; Other Record Changes &gt; Death of a Member</td>
</tr>
<tr>
<td>Directory of Members</td>
<td>Lists &gt; Directory of Members</td>
<td>Reports/Forms &gt; More &gt; Directories &gt; Directory of Members</td>
</tr>
<tr>
<td>Donations—Enter Donations</td>
<td>Finance &gt; Enter Donations, or press Ctrl+D</td>
<td>Finances &gt; Enter Donations, or press Ctrl+D</td>
</tr>
<tr>
<td>Donations—View or Update Donations</td>
<td>Finance &gt; View/Update Donations</td>
<td>Finances &gt; View/Update Donations</td>
</tr>
<tr>
<td>Donors—Add or Update Donors</td>
<td>Finance &gt; Add/Update Donors</td>
<td>Finances &gt; More &gt; Donations &gt; Add/Update Donors</td>
</tr>
<tr>
<td>Donor Statements</td>
<td>Finance &gt; Finance Reports &gt; Donor Statements</td>
<td>Finances &gt; More &gt; Reports/Reconcile &gt; Donor Statements</td>
</tr>
<tr>
<td>Elders</td>
<td>Organizations &gt; Elders</td>
<td>Organizations &gt; Elders</td>
</tr>
<tr>
<td>Endowment without Recommend</td>
<td>Membership &gt; Temple Recommends &gt; Endowed without Recommend</td>
<td>Membership Records &gt; More &gt; Temple Recommends &gt; Endowed without Recommend</td>
</tr>
<tr>
<td>Endowment—Record Endowment</td>
<td>— — —</td>
<td>Membership Records &gt; Record Ordinances &gt; Temple &gt; Record Endowment</td>
</tr>
<tr>
<td>Enter Donations</td>
<td>Finance &gt; Enter Donations, or press Ctrl+D</td>
<td>Finances &gt; Enter Donations, or press Ctrl+D</td>
</tr>
<tr>
<td>Enter Expenses</td>
<td>Finance &gt; Enter Expenses, or press Ctrl+E</td>
<td>Finances &gt; Enter Expenses, or press Ctrl+E</td>
</tr>
<tr>
<td>Enter Home Teaching Visits</td>
<td>Organizations &gt; HT Reporting &gt; Enter HT Visits</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Reporting &gt; Enter HT Visits</td>
</tr>
<tr>
<td>Enter Tithing Declarations</td>
<td>Finance &gt; Tithing Settlement &gt; Tithing Declarations &gt; Enter Tithing Declarations</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Tithing Declarations &gt; Enter Tithing Declarations</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enter Transfers</td>
<td>Finance &gt; Enter Transfers, or press Ctrl+F</td>
<td>Finances &gt; More &gt; Transfers &gt; Enter Transfers, or press Ctrl+F</td>
</tr>
<tr>
<td>Enter Visiting Teaching Contacts</td>
<td>Organizations &gt; VT Reporting &gt; Enter VT Contacts</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Reporting &gt; Enter VT Contacts</td>
</tr>
<tr>
<td>Exit</td>
<td>File &gt; Exit, or press Ctrl+Q</td>
<td>Click Exit on bottom left of screen</td>
</tr>
<tr>
<td>Expenses—Add or Update Payees</td>
<td>Finance &gt; Add/Update Payees</td>
<td>Finances &gt; More &gt; Expenses &gt; Add/Update Payees</td>
</tr>
<tr>
<td>Expenses—Enter Expenses</td>
<td>Finance &gt; Enter Expenses or press Ctrl+E</td>
<td>Finances &gt; Enter Expenses or press Ctrl+E</td>
</tr>
<tr>
<td>Expenses—View or Update Expenses</td>
<td>Finance &gt; View/Update Expenses</td>
<td>Finances &gt; More &gt; Expenses &gt; View/Update Expenses</td>
</tr>
<tr>
<td>Export</td>
<td>File &gt; Export</td>
<td>— — —</td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast Offerings</td>
<td>Finance &gt; Fast Offerings [Select Recipient Report or Add/Update Recipients]</td>
<td>Finances &gt; More &gt; Fast Offering [Select Recipient Report or Add/Update Recipients]</td>
</tr>
<tr>
<td>Fast Offerings—Add or Update Recipients</td>
<td>Finance &gt; Fast Offerings &gt; Add/Update Recipients</td>
<td>Finances &gt; More &gt; Fast Offering &gt; Add/Update Recipients</td>
</tr>
<tr>
<td>Finance Record Transaction Report</td>
<td>File &gt; Finance Record Transaction Report</td>
<td>— — —</td>
</tr>
<tr>
<td>Finance Reports</td>
<td>Finance &gt; Finance Reports [Select Donor Statements or Income and Expense Report]</td>
<td>Finances &gt; More &gt; Reports/Reconcile [Select Donor Statements or Income and Expense Report]</td>
</tr>
<tr>
<td>Frequently Asked Questions</td>
<td>Help &gt; Frequently Asked Questions [Not available in all languages]</td>
<td>— — —</td>
</tr>
<tr>
<td>G</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Geo Codes—Household Geo Codes</td>
<td>Membership &gt; Household Geo Codes</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; View and Update &gt; Household Geo Codes</td>
</tr>
<tr>
<td>H</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>Help &gt; Help or press F1</td>
<td>— — —</td>
</tr>
<tr>
<td>High Priests</td>
<td>Organizations &gt; High Priests</td>
<td>Organizations &gt; High Priests</td>
</tr>
<tr>
<td>Home and Visiting Teaching</td>
<td>Organizations &gt; [Select from HT Organization, HT Reporting, VT Organization, or VT Reporting menus]</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; [Select from HT Organization, HT Reporting, VT Organization, or VT Reporting menus]</td>
</tr>
<tr>
<td>Home Teaching—Enter HT Visits</td>
<td>Organizations &gt; HT Reporting &gt; Enter HT Visits</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Reporting &gt; Enter HT Visits</td>
</tr>
<tr>
<td>Home Teaching Assignments</td>
<td>Organizations &gt; HT Organization &gt; HT Assignments</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Organization &gt; HT Assignments</td>
</tr>
<tr>
<td>Home Teaching Companionships</td>
<td>Organizations &gt; HT Organization &gt; HT Companionships</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Organization &gt; HT Companionships</td>
</tr>
<tr>
<td>Home Teaching Districts</td>
<td>Organizations &gt; HT Organization &gt; HT Districts</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Organization &gt; HT Districts</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Home Teaching—Households Being Taught</td>
<td>Organizations &gt; HT Organization &gt; Households Being Taught</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Organization &gt; Households Being Taught</td>
</tr>
<tr>
<td>Home Teaching—Household Reports (Print)</td>
<td>Lists &gt; Reports &gt; Household Reports</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Organization &gt; Household Report</td>
</tr>
<tr>
<td>Home Teaching Organization</td>
<td>Organizations &gt; HT Organization &gt; [Select from list]</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Organization &gt; [Select from list]</td>
</tr>
<tr>
<td>Home Teaching—Print Blank HT Report</td>
<td>— — —</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Reporting &gt; Print Blank HT Report</td>
</tr>
<tr>
<td>Home Teaching Reporting</td>
<td>Organizations &gt; HT Reporting &gt; [Select HT Visits or HT Statistics]</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Reporting &gt; [Select HT Visits or HT Statistics]</td>
</tr>
<tr>
<td>Home Teaching Statistics</td>
<td>Organizations &gt; HT Reporting &gt; HT Statistics</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Reporting &gt; HT Statistics</td>
</tr>
<tr>
<td>Household GEO Codes</td>
<td>Membership &gt; Household GEO Codes</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; View and Update &gt; Household GEO Codes</td>
</tr>
<tr>
<td>Household Records (Print)</td>
<td>Membership &gt; Print Records &gt; Household Records</td>
<td>Membership Records &gt; More &gt; Print Records &gt; Household Records</td>
</tr>
<tr>
<td>Household Records (View)</td>
<td>Membership &gt; Household Record, or press Ctrl+H</td>
<td>Membership Records &gt; More &gt; View and Update &gt; Household Record</td>
</tr>
<tr>
<td>Household Reports (Print)</td>
<td>Lists &gt; Reports &gt; Household Reports</td>
<td>Reports/Forms &gt; More &gt; Reports &gt; Household Reports</td>
</tr>
<tr>
<td>Households Being Taught</td>
<td>Organizations &gt; HT Organization &gt; Households Being Taught</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Organization &gt; Households Being Taught</td>
</tr>
<tr>
<td>Household's IOS</td>
<td>Membership &gt; Print Records &gt; Household’s IOS</td>
<td>Membership Records &gt; More &gt; Print Records &gt; Household’s IOS</td>
</tr>
<tr>
<td>Import</td>
<td>File &gt; Import</td>
<td>— — —</td>
</tr>
<tr>
<td>Individual Membership Records (Print)</td>
<td>Membership &gt; Print Records &gt; Individual Member Records</td>
<td>Membership Records &gt; More &gt; Print Records &gt; Individual Member Records</td>
</tr>
<tr>
<td>Individual Membership Records (View)</td>
<td>Membership &gt; Individual Record or press Ctrl+I</td>
<td>Membership Records &gt; More &gt; View and Update &gt; Individual Record or press Ctrl+I</td>
</tr>
<tr>
<td>Individual's IOS (Print)</td>
<td>Membership &gt; Print Records &gt; Individual's IOS</td>
<td>Membership Records &gt; More &gt; Print Records &gt; Individual's IOS</td>
</tr>
<tr>
<td>Institute Attendance Report</td>
<td>Other Resources &gt; Church Educational System &gt; Institute Attendance Report</td>
<td>Other Resources &gt; Church Educational System &gt; Attendance &gt; Institute Attendance Report</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Institute Graduation Report</td>
<td>Other Resources &gt; Church Educational System &gt; Institute Graduation Report</td>
<td>Other Resources &gt; Church Educational System &gt; Graduation &gt; Institute Graduation Report</td>
</tr>
<tr>
<td>Institute Students</td>
<td>Other Resources &gt; Church Educational System &gt; Institute</td>
<td>Other Resources &gt; Church Educational System &gt; Student Enrollment &gt; Institute</td>
</tr>
<tr>
<td>IOS—Household’s IOS (Print)</td>
<td>Membership &gt; Print Records &gt; Household’s IOS</td>
<td>Membership Records &gt; More &gt; Print Records &gt; Household’s IOS</td>
</tr>
<tr>
<td>IOS—Individual’s IOS (Print)</td>
<td>Membership &gt; Print Records &gt; Individual’s IOS</td>
<td>Membership Records &gt; More &gt; Print Records &gt; Individual’s IOS</td>
</tr>
<tr>
<td>L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Laurels</td>
<td>Organizations &gt; Young Women &gt; Laurels</td>
<td>Organizations &gt; More &gt; Young Women &gt; Laurels</td>
</tr>
<tr>
<td>Leader Action Lists</td>
<td>Lists &gt; Other Lists [Select from list]</td>
<td>Reports/Forms &gt; More &gt; Lists [Select from list]</td>
</tr>
<tr>
<td>Log Off</td>
<td>File &gt; Log Off</td>
<td>Click Log Off on bottom left of screen</td>
</tr>
<tr>
<td>M</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Marriage—Record Civil Marriage</td>
<td>Membership &gt; Ordinances &gt; Record Civil Marriage</td>
<td>Membership Records &gt; Record Ordinances &gt; Marriage &gt; Record Civil Marriage</td>
</tr>
<tr>
<td>Marriage—Record Temple Marriage</td>
<td>Membership &gt; Ordinances &gt; Record Temple Marriage</td>
<td>Membership Records &gt; Record Ordinances &gt; Marriage &gt; Record Temple Marriage</td>
</tr>
<tr>
<td>Marriage—Terminate Marriage</td>
<td>— — —</td>
<td>Membership Records &gt; Record Ordinances &gt; Marriage &gt; Terminate Marriage</td>
</tr>
<tr>
<td>Members List</td>
<td>Lists &gt; Other Lists &gt; Members List</td>
<td>Reports/Forms &gt; More &gt; Lists &gt; Members List</td>
</tr>
<tr>
<td>Members Moved In</td>
<td>Lists &gt; Other Lists &gt; Members Moved In</td>
<td>Reports/Forms &gt; More &gt; Lists &gt; Members Moved In</td>
</tr>
<tr>
<td>Members Moved Out</td>
<td>Lists &gt; Other Lists &gt; Members Moved Out</td>
<td>Reports/Forms &gt; More &gt; Lists &gt; Members Moved Out</td>
</tr>
<tr>
<td>Members with Callings</td>
<td>Organizations &gt; Reports &gt; Members with Callings</td>
<td>Organizations &gt; More &gt; Reports &gt; Members with Callings</td>
</tr>
<tr>
<td>Members without Callings</td>
<td>Organizations &gt; Reports &gt; Members without Callings</td>
<td>Organizations &gt; More &gt; Reports &gt; Members without Callings</td>
</tr>
<tr>
<td>Membership Records—Household Records (Print)</td>
<td>Membership &gt; Print Records &gt; Household Records</td>
<td>Membership Records &gt; More &gt; Print Records &gt; Household Records</td>
</tr>
<tr>
<td>Membership Records—Household Records (View)</td>
<td>Membership &gt; Household Record, or press Ctrl+H</td>
<td>Membership Records &gt; More &gt; View and Update &gt; Household Record, or press Ctrl+H</td>
</tr>
<tr>
<td>Membership Records—Individual Membership Records (Print)</td>
<td>Membership &gt; Individual Record, or press Ctrl+I</td>
<td>Membership Records &gt; More &gt; View and Update &gt; Individual Record, or press Ctrl+I</td>
</tr>
<tr>
<td>Membership Records—Individual Membership Records (View)</td>
<td>Membership &gt; Individual Record, or press Ctrl+I</td>
<td>Membership Records &gt; More &gt; View and Update &gt; Individual Record, or press Ctrl+I</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Membership Records—Print Records</td>
<td>Membership &gt; Print Records [Select from list]</td>
<td>Membership Records &gt; More &gt; Print Records [Select from list]</td>
</tr>
<tr>
<td>Membership Record Transaction Report</td>
<td>File &gt; Membership Record Transaction Report</td>
<td>— — —</td>
</tr>
<tr>
<td>Membership Validation Report</td>
<td>Membership &gt; Membership Validation Report</td>
<td>Membership Records &gt; More &gt; View and Update &gt; Membership Validation Report</td>
</tr>
<tr>
<td>Messages</td>
<td>Lists &gt; Messages</td>
<td>Unit Name Panel &gt; Messages</td>
</tr>
<tr>
<td>Mia Maids</td>
<td>Organizations &gt; Young Women &gt; Mia Maids</td>
<td>Organizations &gt; More &gt; Young Women &gt; Mia Maids</td>
</tr>
<tr>
<td>Move Household Records Out</td>
<td>Membership &gt; Move Household Records Out, or press Ctrl+M</td>
<td>Membership Records &gt; Move Records Out &gt; Move Household Record &gt; OK, or press Ctrl+M</td>
</tr>
<tr>
<td>Move Individual Record Out</td>
<td>Membership &gt; Move Individual Record Out</td>
<td>Membership Records &gt; Move Records Out &gt; Move Individual Record &gt; OK</td>
</tr>
<tr>
<td>N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Child of Record</td>
<td>Membership &gt; Records &gt; New Child of Record</td>
<td>Membership Records &gt; More &gt; Create Records &gt; New Child of Record</td>
</tr>
<tr>
<td>New Member Report</td>
<td>Lists &gt; Reports &gt; New Member Report</td>
<td>Reports/Forms &gt; More &gt; Reports &gt; New Member Report</td>
</tr>
<tr>
<td>Nonmember Record</td>
<td>Membership &gt; Records &gt; Nonmember Record</td>
<td>Membership Records &gt; More &gt; Create Records &gt; Nonmember Record</td>
</tr>
<tr>
<td>Nonmember—Remove Nonmember</td>
<td>Membership &gt; Records &gt; Remove Nonmember</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; Other Record Changes &gt; Remove Nonmember</td>
</tr>
<tr>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Officers Sustained Forms (Print)</td>
<td>Lists &gt; Forms/Certificates &gt; Print Form [Select Officers Sustained]</td>
<td>Reports/Forms &gt; More &gt; Forms/Certificates &gt; Print Form [Select Officers Sustained]</td>
</tr>
<tr>
<td>Ordinances</td>
<td>Membership &gt; Ordinances [Select from list of ordinances]</td>
<td>Membership Records &gt; Record Ordinances [Select from page of ordinances]</td>
</tr>
<tr>
<td>Other Callings</td>
<td>Organizations &gt; Other Callings</td>
<td>Organizations &gt; More &gt; Bishopric/Other Callings &gt; Other Callings</td>
</tr>
<tr>
<td>Out of Unit Member Record</td>
<td>Membership &gt; Records &gt; Out of Unit Member Record</td>
<td>Membership Records &gt; More &gt; Create Records &gt; Out of Unit Member Records</td>
</tr>
<tr>
<td>Out of Unit—Remove Out of Unit Member</td>
<td>Membership &gt; Records &gt; Remove Out of Unit Member</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; Other Record Changes &gt; Remove Out of Unit Member</td>
</tr>
<tr>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Setup</td>
<td>File &gt; Page Setup [Only when printing is available]</td>
<td>— — —</td>
</tr>
<tr>
<td>Password—Change Password</td>
<td>Edit &gt; Change Password</td>
<td>Unit Name Panel &gt; Change Password</td>
</tr>
<tr>
<td>Priesthood Ordination</td>
<td>Membership &gt; Ordinances &gt; Record Priesthood Ordination</td>
<td>Membership Records &gt; Record Ordinances &gt; Priesthood Ordination &gt; Record Priesthood Ordination</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Priesthood Ordination Record Form</td>
<td>Lists &gt; Forms/Certificates &gt; Print Form [Select from: Aaronic Priesthood Ordination Record or Melchizedek Priesthood Ordination Record]</td>
<td>Reports/Forms &gt; More &gt; Forms/Certificates &gt; Print Form [Select from: Aaronic Priesthood Ordination Record or Melchizedek Priesthood Ordination Record]</td>
</tr>
<tr>
<td>Priesthood Ordination—Record Priesthood Ordination</td>
<td>Membership &gt; Ordinances &gt; Record Priesthood Ordination</td>
<td>Membership Records &gt; Record Ordinations &gt; Priesthood Ordination &gt; Record Priesthood Ordination</td>
</tr>
<tr>
<td>Priests</td>
<td>Organizations &gt; Young Men &gt; Priests</td>
<td>Organizations &gt; More &gt; Young Men &gt; Priests</td>
</tr>
<tr>
<td>Primary</td>
<td>Organizations &gt; Primary</td>
<td>Organizations &gt; More &gt; Bishopric/Other Callings &gt; Primary</td>
</tr>
<tr>
<td>Print</td>
<td>File &gt; Print, or press Ctrl+P [Only when printing is available]</td>
<td>— — —</td>
</tr>
<tr>
<td>Print Blank Home Teaching Report</td>
<td>— — —</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; HT Reporting &gt; Print Blank HT Report</td>
</tr>
<tr>
<td>Print Blank Quarterly Report</td>
<td>Lists &gt; Reports &gt; Print Blank Quarterly Report</td>
<td>Reports/Forms &gt; More &gt; Reports &gt; Print Blank Quarterly Report</td>
</tr>
<tr>
<td>Print Blank Tithing Statement</td>
<td>Finance &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Blank Statement</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Blank Statement</td>
</tr>
<tr>
<td>Print Blank Visiting Teaching Report</td>
<td>— — —</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Reporting &gt; Print Blank VT Report</td>
</tr>
<tr>
<td>Print Form</td>
<td>Lists &gt; Forms/Certificates &gt; Print Form [Select from list of forms]</td>
<td>Reports/Forms &gt; More &gt; Forms/Certificates &gt; Print Form [Select from list of forms]</td>
</tr>
<tr>
<td>Print Household Tithing Statements</td>
<td>Finance &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Household Statements</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Household Statements</td>
</tr>
<tr>
<td>Print Individual Tithing Statements</td>
<td>Finance &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Individual Statements</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Individual Statements</td>
</tr>
<tr>
<td>Print Mailing Labels</td>
<td>File &gt; Print Mailing Labels [Must have a list of members on the screen]</td>
<td>— — —</td>
</tr>
<tr>
<td>Print Preview</td>
<td>File &gt; Print Preview, or press Ctrl+Shift+P</td>
<td>— — —</td>
</tr>
<tr>
<td>Print Records</td>
<td>Membership &gt; Print Records [Select from list]</td>
<td>Membership Records &gt; More &gt; Print Records [Select from list]</td>
</tr>
<tr>
<td>Print Rolls and Lists</td>
<td>Organizations &gt; Reports &gt; Print Rolls and Lists</td>
<td>Organizations &gt; More &gt; Reports &gt; Print Rolls and Lists</td>
</tr>
<tr>
<td>Print Tithing Declaration Report</td>
<td>Finance &gt; Tithing Settlement &gt; Print Reports &gt; Tithing Declaration Report</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Print Reports &gt; Tithing Declaration Report</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quarterly Report</td>
<td>Lists &gt; Reports &gt; Quarterly Report</td>
<td>Reports/Forms &gt; More &gt; Reports &gt; Quarterly Report</td>
</tr>
<tr>
<td>Quarterly Report—Print Blank Quarterly Report</td>
<td>Lists &gt; Reports &gt; Print Blank Quarterly Report</td>
<td>Reports/Forms &gt; More &gt; Reports &gt; Print Blank Quarterly Report</td>
</tr>
<tr>
<td>Recommend Books</td>
<td>Membership &gt; Temple Recommends &gt; Recommend Books</td>
<td>Membership Records &gt; More &gt; Temple Recommends &gt; Recommend Books</td>
</tr>
<tr>
<td>Recommends—View Recommends</td>
<td>Membership &gt; Temple Recommends &gt; View Recommends</td>
<td>Membership Records &gt; More &gt; Temple Recommends &gt; View Recommends</td>
</tr>
<tr>
<td>Reconcile</td>
<td>Finance &gt; Reconcile</td>
<td>Finances &gt; More &gt; Reports/Reconcile &gt; Reconcile</td>
</tr>
<tr>
<td>Record Child Blessing</td>
<td>Membership &gt; Ordinances &gt; Record Child Blessing</td>
<td>Membership Records &gt; Record Ordinances &gt; Child Blessing &gt; Record Child Blessing</td>
</tr>
<tr>
<td>Record Civil Marriage</td>
<td>Membership &gt; Ordinances &gt; Record Civil Marriage</td>
<td>Membership Records &gt; Record Ordinances &gt; Marriage &gt; Record Civil Marriage</td>
</tr>
<tr>
<td>Record Endowment</td>
<td>— — —</td>
<td>Membership Records &gt; Record Ordinances &gt; Temple &gt; Record Endowment</td>
</tr>
<tr>
<td>Record-Priesthood Ordination</td>
<td>Help &gt; Record-Keeping Training</td>
<td>— — —</td>
</tr>
<tr>
<td>Record Priesthood Ordination</td>
<td>Membership &gt; Ordinances &gt; Record Priesthood Ordination</td>
<td>Membership Records &gt; Record Ordinances &gt; Priesthood Ordination &gt; Record Priesthood Ordination</td>
</tr>
<tr>
<td>Records</td>
<td>Membership &gt; Records [Select from list]</td>
<td>— — —</td>
</tr>
<tr>
<td>Record Sealing to Parents</td>
<td>— — —</td>
<td>Membership Records &gt; Record Ordinances &gt; Temple &gt; Record Sealing to Parents</td>
</tr>
<tr>
<td>Record Sealing to Spouse</td>
<td>— — —</td>
<td>Membership Records &gt; Record Ordinances &gt; Temple &gt; Record Sealing to Spouse</td>
</tr>
<tr>
<td>Record Temple Marriage</td>
<td>Membership &gt; Ordinances &gt; Record Temple Marriage</td>
<td>Membership Records &gt; Record Ordinances &gt; Marriage &gt; Record Temple Marriage</td>
</tr>
<tr>
<td>Relief Society</td>
<td>Organizations &gt; Relief Society</td>
<td>Organizations &gt; Relief Society</td>
</tr>
<tr>
<td>Remove Nonmember</td>
<td>Membership &gt; Records &gt; Remove Nonmember</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; Other Record Changes &gt; Remove Nonmember</td>
</tr>
<tr>
<td>Remove Out of Unit Member</td>
<td>Membership &gt; Records &gt; Remove Out of Unit Member</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; Other Record Changes &gt; Remove Out of Unit Member</td>
</tr>
<tr>
<td>Remove Temporary Records</td>
<td>Membership &gt; Records &gt; Remove Temporary Records</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; Other Record Changes &gt; Remove Temporary Records</td>
</tr>
<tr>
<td>Report of Administrative Action</td>
<td>Other Resources &gt; Confidential Forms &gt; Report of Administrative Action</td>
<td>Other Resources &gt; Confidential Forms &gt; Report of Administrative Action</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Reports</td>
<td>Organizations &gt; Reports [Select from list] and Lists &gt; Reports [Select from list] (This brings up two separate lists.)</td>
<td>Membership Records &gt; Request Records &gt; Request Household Record &gt; OK</td>
</tr>
<tr>
<td>Request Household Records</td>
<td>Membership &gt; Request Household Records</td>
<td>Membership Records &gt; Request Records &gt; Request Household Record &gt; OK</td>
</tr>
<tr>
<td>Request Individual Record</td>
<td>Membership &gt; Request Individual Record</td>
<td>Membership Records &gt; Request Records &gt; Request Individual Record &gt; OK</td>
</tr>
<tr>
<td>Request Unit Refresh Data</td>
<td>File &gt; Request Unit Refresh Data</td>
<td>Membership Records &gt; Request Records &gt; Request Individual Record &gt; OK</td>
</tr>
<tr>
<td>Restore from a File</td>
<td>File &gt; Restore from a File</td>
<td>Membership Records &gt; Request Records &gt; Request Individual Record &gt; OK</td>
</tr>
<tr>
<td>Rolls and Lists—Print Rolls and Lists</td>
<td>Organizations &gt; Reports &gt; Print Rolls and Lists</td>
<td>Organizations &gt; More &gt; Reports &gt; Print Rolls and Lists</td>
</tr>
<tr>
<td>Sealing—Record Sealing to Parents</td>
<td>Membership Records &gt; Record Ordinances &gt; Temple &gt; Record Sealing to Parents</td>
<td>Membership Records &gt; Record Ordinances &gt; Temple &gt; Record Sealing to Parents</td>
</tr>
<tr>
<td>Sealing—Record Sealing to Spouse</td>
<td>Membership Records &gt; Record Ordinances &gt; Temple &gt; Record Sealing to Spouse</td>
<td>Membership Records &gt; Record Ordinances &gt; Temple &gt; Record Sealing to Spouse</td>
</tr>
<tr>
<td>Seminary Attendance Report</td>
<td>Other Resources &gt; Church Educational System &gt; Seminary Attendance Report</td>
<td>Other Resources &gt; Church Educational System &gt; Attendance &gt; Seminary Attendance Report</td>
</tr>
<tr>
<td>Seminary Daily and Home Study</td>
<td>Other Resources &gt; Church Educational System &gt; Seminary Daily and Home Study</td>
<td>Other Resources &gt; Church Educational System &gt; Student Enrollment &gt; Seminary Daily and Home Study</td>
</tr>
<tr>
<td>Seminary Graduation Report</td>
<td>Other Resources &gt; Church Educational System &gt; Seminary Graduation Report</td>
<td>Other Resources &gt; Church Educational System &gt; Graduation &gt; Seminary Graduation Report</td>
</tr>
<tr>
<td>Seminary Released-Time</td>
<td>Other Resources &gt; Church Educational System &gt; Seminary Released-Time</td>
<td>Other Resources &gt; Church Educational System &gt; Student Enrollment &gt; Seminary Released-Time</td>
</tr>
<tr>
<td>Seminary Released-Time Form</td>
<td>Other Resources &gt; Church Educational System &gt; Seminary Released-Time Form</td>
<td>Other Resources &gt; Church Educational System &gt; Student Enrollment &gt; Seminary Released-Time Form</td>
</tr>
<tr>
<td>Send and Receive Changes</td>
<td>File &gt; Send/Receive Changes</td>
<td>Unit Name Panel &gt; Send/Receive Changes</td>
</tr>
<tr>
<td>Send Membership Data to Stake</td>
<td>File &gt; Send Membership Data to Stake</td>
<td>Membership Records &gt; Request Records &gt; Request Individual Record &gt; OK</td>
</tr>
<tr>
<td>Signature Card (Print)</td>
<td>Lists &gt; Forms/Certificates &gt; Print Form [Select Signature Card]</td>
<td>Reports/Forms &gt; More &gt; Forms/Certificates &gt; Print Form [Select Signature Card]</td>
</tr>
<tr>
<td>Single Adult Members</td>
<td>Organizations &gt; Single Members</td>
<td>Organizations &gt; More &gt; Adults &gt; Single Members</td>
</tr>
<tr>
<td>Sisters Being Taught (Visiting Teaching)</td>
<td>Organizations &gt; VT Organization &gt; Sisters Being Taught</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Organization &gt; Sisters Being Taught</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Special Requests</td>
<td>Membership &gt; Records &gt; Special Requests</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; Other Record Changes &gt; Special Requests</td>
</tr>
<tr>
<td>Stake Name</td>
<td>Edit &gt; System Options &gt; Unit</td>
<td>Unit Name Panel &gt; System Options &gt; Unit</td>
</tr>
<tr>
<td>Sunday School</td>
<td>Organizations &gt; Sunday School</td>
<td>Organizations &gt; More &gt; Bishopric/Other Callings &gt; Sunday School</td>
</tr>
<tr>
<td>System Options</td>
<td>Edit &gt; System Options</td>
<td>Unit Name Panel &gt; System Options</td>
</tr>
<tr>
<td>Teachers (Aaronic Priesthood)</td>
<td>Organizations &gt; Young Men &gt; Teachers</td>
<td>Organizations &gt; More &gt; Young Men &gt; Teachers</td>
</tr>
<tr>
<td>Telephone Directory</td>
<td>Lists &gt; Telephone Directory, or press Ctrl+T</td>
<td>Reports/Forms &gt; Telephone Directory, or press Ctrl+T</td>
</tr>
<tr>
<td>Temple—Adult Members Not Endowed</td>
<td>Membership &gt; Temple Recommends &gt; Adult Members Not Endowed</td>
<td>Membership Records &gt; More &gt; Temple Recommends &gt; More &gt; Adult Members Not Endowed</td>
</tr>
<tr>
<td>Temple—Endowed without a Recommend</td>
<td>Membership &gt; Temple Recommends &gt; Endowed without a Recommend</td>
<td>Membership Records &gt; More &gt; Temple Recommends &gt; Endowed without a Recommend</td>
</tr>
<tr>
<td>Temple Recommends</td>
<td>Membership &gt; Temple Recommends [Select from list]</td>
<td>Membership Records &gt; More &gt; Temple Recommends &gt; More [Select from list]</td>
</tr>
<tr>
<td>Temple—Record Temple Marriage</td>
<td>Membership &gt; Ordinances &gt; Record Temple Marriage</td>
<td>Membership Records &gt; Record Ordinances &gt; Marriage &gt; Record Temple Marriage</td>
</tr>
<tr>
<td>Temporary—Remove Temporary Records</td>
<td>Membership &gt; Records &gt; Remove Temporary Records</td>
<td>Membership Records &gt; More &gt; View and Update &gt; More &gt; Other Record Changes &gt; Remove Temporary Records</td>
</tr>
<tr>
<td>Terminate Marriage</td>
<td>— — —</td>
<td>Membership Records &gt; Record Ordinances &gt; Marriage &gt; Terminate Marriage</td>
</tr>
<tr>
<td>Tithing Declaration</td>
<td>Finance &gt; Tithing Settlement &gt; Tithing Declarations</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Tithing Declarations &gt; Enter Tithing Declarations</td>
</tr>
<tr>
<td>Tithing Declaration Report</td>
<td>Finance &gt; Tithing Settlement &gt; Print Reports &gt; Tithing Declaration Report</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Print Reports &gt; Tithing Declaration Report</td>
</tr>
<tr>
<td>Tithing—Enter Tithing Declarations</td>
<td>Finance &gt; Tithing Settlement &gt; Tithing Declarations &gt; Enter Tithing Declarations</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Tithing Declarations &gt; Enter Tithing Declarations</td>
</tr>
<tr>
<td>Tithing—Print Blank Tithing Statement</td>
<td>Finance &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Blank Statement</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Blank Statement</td>
</tr>
<tr>
<td>Tithing—Print Household Tithing Statements</td>
<td>Finance &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Household Statements</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Household Statements</td>
</tr>
<tr>
<td>Tithing—Print Individual Tithing Statements</td>
<td>Finance &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Individual Statements</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Tithing Statements &gt; Print Individual Statements</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tithing—Print Tithing</td>
<td>Finance &gt; Tithing Settlement &gt; Print Reports &gt; Tithing Declaration Report</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement &gt; Print Reports &gt; Tithing Declaration Report</td>
</tr>
<tr>
<td>Declaration Report</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tithing Settlement</td>
<td>Finance &gt; Tithing Settlement</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement</td>
</tr>
<tr>
<td>Tithing—Enter Transfers</td>
<td>Finance &gt; Enter Transfers, or press Ctrl+F</td>
<td>Finances &gt; More &gt; Transfers &gt; Enter Transfers, or press Ctrl+F</td>
</tr>
<tr>
<td>Tithing—View Transfers</td>
<td>Finance &gt; View Transfers</td>
<td>Finances &gt; More &gt; Transfers &gt; View Transfers</td>
</tr>
<tr>
<td>Tithing—Enter Transfers</td>
<td>Finance &gt; Tithing Settlement</td>
<td>Finances &gt; More &gt; Donations &gt; Tithing Settlement</td>
</tr>
<tr>
<td>Tithing—View Transfers</td>
<td>Finance &gt; View Transfers</td>
<td>Finances &gt; More &gt; Transfers &gt; View Transfers</td>
</tr>
<tr>
<td>Unit Statistics</td>
<td>Lists &gt; Reports &gt; Unit Statistics</td>
<td>Reports/Forms &gt; More &gt; Reports &gt; Unit Statistics</td>
</tr>
<tr>
<td>Urgent Tasks</td>
<td></td>
<td>Unit Name Panel &gt; Urgent Tasks</td>
</tr>
<tr>
<td>View or Edit Budget</td>
<td>Finance &gt; Budget &gt; View/Edit Budget</td>
<td>Finances &gt; More &gt; Budget &gt; View/Edit Budget</td>
</tr>
<tr>
<td>View or Update Donations</td>
<td>Finance &gt; View/Update Donations</td>
<td>Finances &gt; View/Update Donations</td>
</tr>
<tr>
<td>View or Update Expenses</td>
<td>Finance &gt; View/Update Expenses</td>
<td>Finances &gt; More &gt; Expenses &gt; View/Update Expenses</td>
</tr>
<tr>
<td>View Recommends</td>
<td>Membership &gt; Temple Recommends &gt; View Recommends</td>
<td>Membership Records &gt; More &gt; Temple Recommends &gt; View Recommends</td>
</tr>
<tr>
<td>View Transfers</td>
<td>Finance &gt; View Transfers</td>
<td>Finances &gt; More &gt; Transfers &gt; View Transfers</td>
</tr>
<tr>
<td>Visiting Teaching Assignments</td>
<td>Organizations &gt; VT Organization &gt; VT Assignments</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Organization &gt; VT Assignments</td>
</tr>
<tr>
<td>Visiting Teaching Companionships</td>
<td>Organizations &gt; VT Organization &gt; VT Companionships</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Organization &gt; VT Companionships</td>
</tr>
<tr>
<td>Visiting Teaching Districts</td>
<td>Organizations &gt; VT Organization &gt; VT Districts</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Organization &gt; VT Districts</td>
</tr>
<tr>
<td>Visiting Teaching—Enter VT Contacts</td>
<td>Organizations &gt; VT Reporting &gt; Enter VT Contacts</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Reporting &gt; Enter VT Contacts</td>
</tr>
<tr>
<td>Visiting Teaching Organization</td>
<td>Organizations &gt; VT Organization [Select from list]</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Organization [Select from list]</td>
</tr>
<tr>
<td>Visiting Teaching—Print Blank VT Report</td>
<td>— — —</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Reporting &gt; Print Blank VT Report</td>
</tr>
<tr>
<td>Visiting Teaching Reporting</td>
<td>Organizations &gt; VT Reporting [Select from list]</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Reporting [Select from list]</td>
</tr>
<tr>
<td>Visiting Teaching—Sisters Being Taught</td>
<td>Organizations &gt; VT Organizations &gt; Sisters Being Taught</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Organization &gt; Sisters Being Taught</td>
</tr>
<tr>
<td>Visiting Teaching Statistics</td>
<td>Organizations &gt; VT Reporting &gt; VT Statistics</td>
<td>Organizations &gt; Home and Visiting Teaching &gt; VT Reporting &gt; VT Statistics</td>
</tr>
<tr>
<td>To go to:</td>
<td>Using the MLS menu bar</td>
<td>Using the MLS on-screen links</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>Ward Birthday List</td>
<td>Lists &gt; Other Lists &gt; Birthday List</td>
<td>Reports/Forms &gt; More &gt; Lists &gt; Birthday List</td>
</tr>
<tr>
<td>Ward Name</td>
<td>Edit &gt; System Options &gt; Unit</td>
<td>Unit Name Panel &gt; System Options &gt; Unit</td>
</tr>
<tr>
<td>Young Men</td>
<td>Organizations &gt; Young Men [Select from list]</td>
<td>Organizations &gt; More &gt; Young Men [Select from list]</td>
</tr>
<tr>
<td>Young Men Leaders</td>
<td>Organizations &gt; Young Men &gt; Young Men Leaders</td>
<td>Organizations &gt; More &gt; Young Men &gt; Young Men Leaders</td>
</tr>
<tr>
<td>Young Women</td>
<td>Organizations &gt; Young Women [Select from list]</td>
<td>Organizations &gt; More &gt; Young Women [Select from list]</td>
</tr>
<tr>
<td>Young Women Leaders</td>
<td>Organizations &gt; Young Women &gt; Young Women Leaders</td>
<td>Organizations &gt; More &gt; Young Men &gt; Young Men Leaders</td>
</tr>
</tbody>
</table>